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Communications regulation information

FCC statement

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. Seeinstructionsif interference to
radio or television reception is suspected.

Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If itisnot installed and used properly—that is, in strict accordance with Apple's
instructions—it may cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specificationsin Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in aresidential installation. However,
there is no guarantee that interference will not occur in a particular installation.

Y ou can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:

= Turnthetelevision or radio antenna until the interference stops.

= Movethe computer to one side or the other of the television or radio.

= Movethe computer farther away from the television or radio.

= Plug the computer into an outlet that is on adifferent circuit from the television or radio.
(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions.

IMPORTANT Changes or modificationsto this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

Use of ashielded cableis required to comply within Class B limits of Part 15 of FCC Rules.
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Industry Canada statement

This Class B device meets al requirements of the Canadian Interference-Causing eguipment
regulations.

Cet appareil numérique de la Class B respecte toutes | es exigences du Reglement sur le matériel
brouilleur du Canada.

VCCI Class 2 statement
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Welcome

Congratulations on your purchase of the Apple Color StyleWriter 4500
printer. This book describes how to set up the printer and how to useit.

Main features of the Color StyleWriter 4500

The Color StyleWriter 4500 prints high-quality color graphics and text on
avariety of materials, including plain paper.

Along with the printer, you have everything you need to print amazingly
photorealistic images—right from your desktop. Thisisideal for printing
scanned images, images from photo CDs, and graphics from the I nternet.

The automatic sheet feeder holds up to 100 sheets of paper, up to 20
envelopes, and 20 sheets of continuous banner paper.

You can connect the printer to a Local Talk network or connect it directly to
your computer with a serial cable

64 available TrueType (outline) fonts print smoothly in a variety of sizes
The Color StyleWriter 4500 works with most Mac OS-based computers.
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System requirements

Chapter 1

To install the printer software and use the Color StyleWriter 4500 printer with
your Mac OS-based computer, you need

s aMac OS-based computer with a 68030/33 MHz or higher central
processing unit (CPU), any Macintosh model except a Macintosh Plus, 1,
SE, Ilg, llci, Classic®, Portable, or PowerBook 100

= Macintosh Operating System (Mac OS) version 71 or alater version

= a least 4 megabytes (MB) of random-access memory (RAM) for a non-
Power Macintosh; if you have a Power Macintosh, 8 MB of RAM isthe
minimum requirement, and 16 MB is recommended

» at least 8 MB of space available on your hard disk for the printer software
The Installer program that comes with the Color StyleWriter 4500

automatically checks whether your computer meets these requirements.
Chapter 1 explains how to use the Installer program.



Setting Up Your Printer

This booklet introduces the Apple Color StyleWriter 4500 printer and
explains how to set it up. After you follow the instructions in this booklet,
youll be ready to print.

Important safety instructions

Always take the following precautions:

Keep the printer cover closed when printing.
Always turn off the printer before unplugging it.
Keep the ink cartridges away from children.

Keep the printer away from sources of liquid, such as wash basins,
bathtubs, and shower stalls

Protect the printer from dampness or wet weather, such as rain and snow.

Read all the installation instructions carefully before you plug the printer
into awall socket.

Keep these instructions handy for reference by you and others
Follow all instructions and warnings dealing with your computer system.

Dot use devices that produce open flames, such as Bunsen burners, near
the printer.
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Chapter 1

» Dot use alcohol-based or ammonia-based cleaners on or around the
printer.

= Always unplug the printer before cleaning it. (Use only the cleaning
procedure recommended in Chapter 4 of the electronic manual that came
with your printer. For information on using the electronic manual, see the
last page of this booklet.

= Clean the outside of the printer with a damp cloth and, if necessary, amild
soap or detergent. Be careful not to get liquid into the printer or the power
cord receptacle

IMPORTANT The only way to disconnect power completely is to unplug the
power adapter. Make sure at least one end of the power cord is within easy
reach so that you can unplug the Color StyleWriter 4500 when you need to.

Watch for these situations, and if one occurs pull the plug!
= the power cord or plug becomes frayed or otherwise damaged
= Yyou spill something into the printer

» the printer is exposed to rain or any other excess moisture

» the printer has been dropped or otherwise damaged

= YyOu suspect that your printer needs service or repair

WARNING Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be supervised by an
adult. Do not allow children access to the interior of any electrical
product and do not permit them to handle any cables.



Unpacking the printer

1 Remove everything from the shipping box, but leave the ink cartridges in their packages.

Floppy disk Color StyleWriter 4500

Ink cartridge
storage case

Power adapter

2 Remove the tape and packing material from the outside of the printer.

Setting Up Your Printer



3 Open the printer’s cover and remove the packing material from the inside of the printer.

Remove the packing material.

Save the carton and the packing material in case you ever need to ship
the printer.

4 Close the printer's cover.
5  Place the printer in your work area.

Choose alocation near your computer that has an electrical outlet and good
ventilation, is out of direct sunlight, never gets damp or very hot or very cold,
and is away from devices that could cause el ectromagnetic interference, such
as stereo speakers or cordless telephone transmitters. Do not place the printer
on adanted surface. See Appendix A, “Technical Information,” for specific
information about the physical requirements of your printer. (Youll find
Appendix A in the electronic manual that came with your printer. For
information on using the electronic manual, see the last page of this booklet)

IMPORTANT Dorit accidentally discard the ink cartridge storage case You need
it to store an opened cartridge that youre not using in the printer. The case
keeps the print head from drying out and prevents accidents with ink stains.

4 ' Chapter 1



Plugging in the printer

Plug the connector end of the power adapter into the printer and then plug the
other end of the adapter into an outlet.

IMPORTANT The only way to disconnect power completely is to unplug the
power adapter. Make sure that at |east one end of the power cord is within
easy reach so that you can unplug the printer in an emergency.

WARNING The Color StyleWriter 4500 is designed to work with the
electrical system of the region in which you purchased it. It works with
only one frequency of electricity, either 50 or 60 Hz. The label on the
adapter you received with your printer indicates the frequency required.

The label on the adapter also indicates the voltage required. If you are
using the printer in aregion with a different voltage but the same
frequency as that listed on the adapter, you must use a voltage converter
to provide the voltage indicated on the adapter label.

Serious damage to the printer will result from using the Color
StyleWriter 4500 adapter with an improper electrical frequency or
improper voltage converter. Damage resulting from such misuse of the
printer is not covered under warranty.

Setting Up Your Printer
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Connecting the printer directly to your computer

Chapter 1

You can connect the printer directly to your computer with a serial cable
If you want to add the printer to a Local Talk network, see the next section,
“Connecting to a Local Talk Network.” You cannot connect the printer
both ways.

Plug the cable into the interface port on the printer.

You can use the serial cable that came with your printer, or you can use a
Local Talk kit and plug a Local Talk cable into the same port.

Some Macintosh
computers have a
combined serial port
with two icons.

Connect this end of the cable
to either the printer port or
the modem port, which are
labeled with these icons.

Plug the other end of the cable into the printer port on your computer.

If your computer is connected to a network, a network cable may aready be
connected to the printer port (&). In that case, use the modem port (%).

Remember which port on the computer you use. Later you must tell the
printer software where to look for the printer.



Some PowerBook computers that have an internal modem installed cannot
tell that the printer is plugged in. You must change a setting in the PowerBook
Setup or Express Modem control panel. For details, see “Special Information
for PowerBook Owners’ in the section “Telling Your Computer to Use the
Color StyleWriter 4500 later in this chapter.

Connecting to a LocalTalk network (optional)

If you have an existing Local Talk network, you can add your printer to it and
share the printer with other Mac OS—-based computers on the network.

IMPORTANT You can either connect the printer directly to your computer
with a serial cable or connect it to aLocal Talk network with a Local Talk
connecting Kit. You cannot connect the printer both ways at the same time

1  Obtain a LocalTalk connecting Kit.

Local Talk connecting kits come in many varieties. A kit usually contains one
connector box and one Local Talk cable Two Local Talk connecting kits are
available from Apple For information about these kits, see “Apple Printer
Supplies and Accessories’ in Appendix A. (You Il find Appendix A in the
electronic manual that came with your printer. For information on using the
electronic manual, see the last page of this booklet)

2 Plug the connector box into the interface port on the printer.

3 Connect the printer to the network in one of these two ways:

= 0 connect the printer to the end of a Local Talk network, use the Local Talk
cable to connect the empty socket of the nearest devicées connector box to
the printer's connector box.

= 10 connect the printer between two devices on a Local Talk network,
disconnect one Local Talk cable from the connector box or the device
immediately to the left or right of the printer and plug it into the new
printer's connector box. Then use the new Local Talk cable to connect the
free socket on the printer's connector box to the socket you freed on the
other devicés connector box.

Setting Up Your Printer
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Turning the printer on and off

Chapter 1

To turn on the printer, press the power button. The green power light glows

To turn the printer off, press the power button again. The power light goes
out.

Resume button

Power button

WARNING Except in an emergency, make sure the printer is turned off
before you unplug it. (When the power light is off, the power is off) If
the printer is plugged into a power strip, never turn off the power strip
unless youve already turned the printer off.

When you turn off the printer, it moves the ink cartridges to the right,
where it caps the nozzles to keep the ink cartridges from drying out. If
you unplug the printer or discontinue power before turning it off, the
printer carit position the cartridges in the capped position, the print
head may dry out, and you Il have to replace the cartridge.



Installing the ink cartridges

Each ink cartridge contains a print head, which sprays the ink onto the paper.
Treat it gently so you don't damage its tiny nozzles.

WARNING The carrier holds the ink cartridges and moves them back and
forth when you are printing a document. Dorit dide the carrier by hand
or you will damage the printer.

1  Toturn on your printer, press the power button.
The power light comes on.
2 Open the front cover.

The carrier moves to the center of the printer, and the resume light flashes

When you turn on the power and

] '
_/ K
A\ / X
N — open the cover, the carrier moves

to the center. Do not slide the
carrier by hand.

Note: If the carrier does not move automatically to the center, try cdlosing the
cover and turning the power off. Then repeat steps 1 and 2.

WARNING Use only ink designed for use with the Color StyleWriter 4500.

Setting Up Your Printer



3 Grasp each ink cartridge by its sides and carefully remove the tape from the cartridge’s
print head.

You may safely touch the colorful caps or the black plastic, but be careful not
to touch any other part.

! Make sure you

remove the tape
— i |_-from both

l . cartridges.

4 Slide the ink cartridges down into the carrier, and then press both cartridges into place.

Note: Open the color and black
ink cartridges. Set the color
PhotoGrade cartridge aside,

still in its protective packaging.
Use it for special projects, not
day-to-day printing.

For the printer to work, you must install two ink cartridges.

Color ink cartridge

Black ink cartridge

When you install the color PhotoGrade ink
cartridge, it goes into this side of the carrier,
(replacing the black ink cartridge.)

Press until you hear a snap, and
the cartridge fits snugly in the
carrier. It should be difficult to
remove. If a cartridge feels loose,
it is not properly seated.

10 ' Chapter 1



5  Close the printer’s front cover.

When you close the cover, you can
hear the carrier move to the right.

IMPORTANT If the resume light
blinks after you close the cover,
the ink cartridges are not
installed properly.

Turn the printer off, then repeat
steps 1 through 5. Be sure to
press both ink cartridges firmly
into place in the carrier.

Storing the ink cartridge you aren't using

The Color StyleWriter 4500 comes with color, black, and color PhotoGrade
cartridges. Sealed in their original packaging, the cartridges are protected. If
you open all three packages and switch between the black and PhotoGrade
cartridges for printing different documents, be sure to store the one youre not
using in the storage case supplied with your Color StyleWriter 4500. The
storage case keeps the print head from drying out and prevents accidents with
ink stains

Black ink

<> _Color PhotoGrade
cartridge @ ink cartridge
AN

>
U
‘ Note: The cartridges face in different
directions when properly inserted in
the storage case.

Keep opened ink cartridges inside the
printer or in the storage case.

IMPORTANT If you are using only two cartridges, leave them inside the printer.

Setting Up Your Printer
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Installing your printer software

Chapter 1

Before you can print your documents, you need to install the printer software
on your computer. The Apple Printer Software Collection CD-ROM disc that
comes with the Color StyleWriter 4500 contains the printer software and an
Installer program.

The Installer installs the new printer software you need, plus the fonts that
come with the printer. (For alist of available fonts, see Appendix C in the
electronic manual that came with your printer. For information on using the
electronic manual, see the last page of this booklet)

If you have been using Applés special QuickDraw GX software, turn it off
now. The Color StyleWriter 4500 is not compatible with QuickDraw GX.

Note: If you ever upgrade your system software (for example, from System 71
to System 7.5), you must reinstall the Color StyleWriter 4500 software

Using the Minimal Printer Software floppy disk

If you have a CD-ROM drive kip to the next section, “Using the Apple
Printer Software Collection CD-ROM Disc”

If you do not have a CD-ROM drive, the Color SyleWriter 4000 Series Minimal
Printer Software floppy disk that came with your printer contains minimal
software that lets you start printing now. For instructions on installing the
software, see the Read Me you |l find on the floppy disk.

In addition, you can contact Apple and ask to have the complete Color
StyleWriter 4500 printer software and fonts mailed to you on a set of floppy
disks You may also download the complete printer software (but not the
fonts) from Apples Web page at http://imaging.applecom.

Note: Any software applications or extra fonts from companies other than
Apple are available only on the CD-ROM disc.

If you have access to a computer with a CD-ROM drive, the Apple Printer
Software Collection CD-ROM disc contains disk images of the complete set of
floppy disks The CD-ROM disc also contains a disk-duplication application
you can use to create your own set of floppy disks See the instructions that
accompany the application



Note: The minimal printer software works with a Color StyleWriter 4500
printer that is connected by a serial cable to your computer. If you want to use
aLocalTalk kit to connect the printer, you must use the software that comes
on the complete disk set.

Now you can go to the section “ Telling Your Computer to Use the Color
StyleWriter 4500 later in this booklet.

Using the Apple Printer Software Collection CD-ROM disc

Turn off any automatic virus-detection applications you have on your Mac OS-based
computer.

If you don't, problems may occur during the installation. After installation
is complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection application, see the manual
that came with the program.)

Insert the Apple Printer Software Collection CD-ROM disc into your CD-ROM drive.
If necessary, double-click the CD-ROM disc icon to open it.

The CD-ROM disc may already be opened on your desktop.

To start the Installer program, double-click its icon.

In the Welcome dialog box that appears, click Continue.

IMPORTANT The Installer determines whether you have the correct system
software, and enough memory and hard disk space to use this printer. If you
dorit, the Installer displays a message telling you what you need. You worit be
abletoinstall the printer software until you correct the system software or
memory problem. If the message reports a problem, you can purchase new
system software or memory from an Apple-authorized deal er, or make space
available on your hard disk by throwing away files you dont need.

Read the software license agreement and click Agree.

If you are unwilling to accept the terms of the agreement, click Disagree

Setting Up Your Printer
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Make sure the disk
named here is the
one on which you
want to install the

printer software.

(If not, click Switch

Disk until the correct
name appears.)

8

Chapter 1

In the Installer dialog box, click Install.

=———— Install (5l 4000 Series =———"115
[ Easy Install |

Click Install to copy:
Apple Color Stylelriter 4000 Series printer software
onto the selected disk.

------ Destination Disk

Eieet Hisk When you're ready to
‘four Hard Disk I[W]I__ begln’ C“Ck lnSta”
[

After afew moments, the Installer begins to install the printer software A
status box keeps you informed of progress during installation.

When you see a message reporting that installation was successful, click Restart.



Installation troubleshooting

If the Installer can't complete the installation, it will issue a warning message
Here are some ways to fix common problems:

= You may not have the correct hardware or system software for this printer.
If so, the Installer will tell you what youre missing.

= You may have forgotten to turn off your virus-detection software as
described in the section “Using the Apple Printer Software Collection
CD-ROM Disc” earlier in this booklet.

= You may have some corrupted fonts on your hard disk. To solve this
problem, see “Installation Is Unsuccessful” in Chapter 5 (Youll find
Chapter 5 in the electronic manual that came with your printer. For
information on using the electronic manual, see the last page of this
booklet)

More information about the Installer program

In the procedure just described the Installer copies all the software you need
to your hard disk. In rare circumstances you may want to copy only a subset
of the software. In that case choose Custom Install from the pop-up menu in
the Installer. When alist of choices appears, select the items you wish to
install, then dlick the Install button. (Click the letter i to the right of any of
the choices for information.)

Power Macintosh users and virtual memory

If you are using a Power Macintosh computer, you may want to turn on
virtual memory before you try to print on the Color StyleWriter 4500. Then
choose a setting that's at least 1 MB higher than your “Available built-in
memory.” (You can set it higher without any ill effects) With this setting, you
will avoid some potential printing problems. Turning on virtual memory also
reduces the amount of memory needed by many applications. For instructions
on turning on virtual memory, see the documentation that came with your
computer.

Setting Up Your Printer ‘ 15
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Telling your computer to use a directly connected Color StyleWriter 4500

If your printer is connected directly to your computer with a serial cable,
follow these instructions for selecting it in the Chooser.

If your printer is connected to a Local Talk network, see the next section,
“Telling Your Computer to Use a Color StyleWriter on a Local Talk Network.”

1  Make sure the printer is turned on.

2 Select Chooser from the Apple (6) menu.

3 Inthe Chooser dialog box, click the appropriate items to select them.

First, click this icon.
(If necessary, use the scroll
bar and arrows to find it.)

S = Chooser

]
Y Select a printer port:
s
AppleShare
g
TS 4000 _ies (AT) Laser'writer
Mack23
]
Background Printing
S—— ) On {® Off
|| O Active
o] | ApmieTalk @ Inactive

Then click one of these
items to indicate which port
you connected the printer to:
the printer port (&) or the
modem port ().

If your computer is a
PowerBook, see “Special
Information for PowerBook
Owners,” later in this booklet.

4 Close the Chooser by clicking the close box in its upper-left corner.

Chapter 1



Telling your computer to use a Color StyleWriter on a LocalTalk network
You can connect a Color StyleWriter 4500 printer directly to a Local Talk

First, click this icon (If

network.

Note: If you do not need to share the printer with other users on the network,

connect the printer directly to your computer with the serial cable The
printer prints faster when connected this way.

Once the printer is on the network, its name appears in the Chooser just like
the names of other network printers.

ECT Chooser
Select a Stylewriter:
Ann’s Printer i
AppleShare S 4000 Series Carol’s Color Printer

necessary, use the
scroll bar and arrows
to find it.).

The “AT” stands for
AppleTalk.

Make sure the __|

StyleWriter 4500
shows in this
pop-up menu.

T

Laserwriter

AppleTalk Zones:

Halftime
Hardware Test Lab

Imaging

Japan
Montana
Second Floor
Third Floar

Instructional Products

Second, click the name of
your printer on this list.

CSW an Netwark

Diane’s Office Printer
Don’s CSw

Larry’s Department Printer
Marie’s Test Printer
Randy’s Color

Ray’s Market Printer

Sue’s World Printer

=

Background Printing

Lsewn )™ 5 o0 @ orr

) Active

AppleTalk ) Inactive

L Finally, click to make
AppleTalk active.

If you want to change the name, click Setup in the dialog box that appears,
type anew name, and click Rename (Note: Anyone on the network can
change the name)

Printer Setup

————
Type: [ Stylelriter 4500 |

WETUTHICSW on Network

Type a new name, then
click Rename (or press Return).

Setting Up Your Printer
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Special information for PowerBook owners

PowerBook computers that have internal modems may require special setups
What you do depends on whether the Powerbook has one or two serial ports
on its back panel.

Note: Thisinformation is for PowerBook users who connect the printer
directly to their computer with a serial cable

PowerBook computers with one serial port

Some PowerBook computers have a single serial port identified by a
combination printer/modem icon (&/%). If an internal modem isinstalled on
one of these PowerBook computers, the serial port may be in use even though
it looks available When you plug in the Color StyleWriter 4500, the
PowerBook may not be able to communicate with the printer.

To make the port available for printing, make sure the serial port setting is
Normal or External. To check the setting, open the PowerBook, PowerBook
Setup, or Express Modem control pandl. (If you have another kind of internal
modem, you may have a different control panel. The control panel and the
setting you use depend on which PowerBook you have and which internal
modem you have) If you have a PowerBook Express Modem, it is best to
leave the serial port setting as Normal or External unless the modem
programs you use require another setting for compatibility reasons

If icons for both ports appear in the Chooser, select the modem port (%).
Also, make sure AppleTalk isinactive

PowerBook computers with two serial ports

Even when a PowerBook has two serial ports, if it also has an internal
modem, the modem port () may look available but actually bein use If the
printer port (&) is available, connect the Color StyleWriter 4500 to it. If the
printer port is unavailable and you must use the modem port, make sure the
modem serial port setting is Normal or External. To check the setting, open
the PowerBook, PowerBook Setup, or Express Modem control pand. (If you
have another kind of internal modem, you may have a different control panel.
The control panel and the setting you use depend on which modem and
system software version you have) If you have a PowerBook Express Modem,
it is best to leave the serial port setting as Normal or External.

For more information, see the instructions that came with your PowerBook.



Loading paper into the paper tray

The paper tray holds up to 100 sheets of 20-pound paper and feeds the paper
automatically into the printer. You can load many sizes of paper and other
media into the sheet feeder, but to align the ink cartridges, as described in the
next section, you must use U.S Letter or A4 paper. To load paper into the
sheet feeder, follow these steps:

1  Slide the paper adjusters out as far as you can.

Length adjuster

Make sure the paper selection
lever is all the way to the left.

2 Make sure the edges are even on all sides before inserting a stack of paper.

Setting Up Your Printer ‘ 19
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3

4

Load the paper into the lower tray, print side down.

The wrapper that the paper comesin usually tells which side to print first.

Slide the paper lengthwise
into the tray, print side down.

Note: Illustrations inside the printer cover remind you how to insert paper
and envelopes correctly.

Slide the paper adjusters in to touch the edges of the stack of paper.




Aligning the ink cartridges

Click Start.

Whenever you install a new ink cartridge, follow these steps:

If necessary, turn on the printer.

The green power light should be on.

IMPORTANT If the resume light blinks, the ink cartridges are not installed
properly. Turn the printer off. Then follow the stepsin “Installing the Ink

Cartridges” earlier in this chapter.

Make sure there is plain paper in the paper tray.

Choose Page Setup from the File menu.

In the Page Setup dialog box, click Utilities.

Color Stylelliriter 4500 Page Setup

Paper Size: Paper Type:
[ US Letter w| [ Plain Paper w]
Orientation: Scaling (%):

Two-Sided Printing:
O i Horizontal [(None  +]

[Juse Color PhotoGrade Ink Cartridge
[ save as Default

Cancel

| Click Utilities.

In the dialog box that appears, find Align Print Cartridges and click Start.

Color StylelWriter 4500 Utilities

Clean Print Cartridge:

Align Print Cartridges:

Cancel

Read the message that appears, and click Align.

cartridges.

edch time either cartridge is replaced.

The following process aligns the patterns of
ink placed on the page by both print

We recommend that you align the cartridges

| Click Align.

Setting Up Your Printer
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7  Examine the patterns that appear on the printed page.

From among the sets of parallel lines, choose the horizontal set and the
vertical set for which the black and magenta lines are most closely aligned.

IMPORTANT If you cannot see black lines, make sure you have removed the
tape from the black ink cartridge If you cannot see magenta lines, remove the
tape from the color ink cartridge

8 Inthedialog box that appears, click the number and letter corresponding to the best
aligned sets, and click OK.

Your printer has printed two sets of alignment

patterns. Look at each pattern carefully.
Ch the best aligned pattern, for each set,
then select the corresponding buttons below.

1 D2 03 04 05 06 D 08 09 D10 011

OR OB OC oD OF OF 26 OH O Od 0K

The printer prints a second page, containing a square and a cross, for you to
verify that the alignment is acceptable

9 If the patterns on the second printed page are acceptable, click OK.

The alignment procedure is complete. Your

printer has printed a square and cross

pattern.

Examine each pattern to ensure that all
black and magenta segments line up. If they
do not, run the alignment process again.
| If the square and cross are

properly aligned, click OK.

To repeat the process, click Align.

10  Click OK in the remaining dialog boxes.

You have finished aligning the ink cartridges in your printer.

Chapter 1



Printing the sample page
To see what your printer can do, print the demonstration page

1  Make sure the printer and computer are turned on.

2  Press and hold down the resume button for three seconds and release it.

Resume button

Power button

—
Make sure the

paper selection lever
is all the way to the left.

The printer prints the sample page, your first full-color document from your
new printer.

2

Color StyleWriter 4500

___Note: You do not need to print this page
every time you use the printer.

Setting Up Your Printer
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Using onscreen help with

CSW 4000 Series Printer Guide is a valuable source of information about
your printer and printer software The Guide menu is identified by a question
mark (@) in the upper-right corner of the screen.

=] @ |

About Apple Guide

Show Balloons

Macintosh Guide A

Shortcuts )
Choose this for onscreen help on

CSL 4000 Series Printer Guide—— how to use your printer.

To open the Printer Guide, make sure you are in the Finder. Then choose
CSW 4000 Series Printer Guide from the Guide (@) menu at the top of your
screen.

Macintosh (or Mac OS) Guide also contains general information about
printing, as well as other information about using your computer. Macintosh
Guide is available while youre in the Finder.

First, click the Topics button.

Color StyleWriter
F—T p e
] 4000 Series =
Printer Guide =
Topics Index Look For
1. Click a topic area: 2, Click a phrase, then click O
[ [Setting Up 7+ [+ How do1
Selecting & Configuring & Printer reduce or enlarge a docurment?
change a document’s orientation?
Frinting on Different Paper print a harizontally fipped image?
Se.COI']d, Choo_se Managing Background Printing print rultiple copies?
atopic from the ||St Using Ink Cartridges print pages in reverse order? H H
p Pririting Tips print on both sides of the paper? Th I rd’ fOf detal|6d
that appears here. | |Troubleshooting BHIRt in gravscale? instructions’ select the

change print quality?

change the default Page Setup settings?
~ Definitions
T AppleTalk

question you want
answered from this list

and click OK.

IMPORTANT A complete reference manual, in electronic form, comes on the
Apple Printer Software Collection CD-ROM disc. The electronic manual is
different from the onscreen help described here For information on using the
electronic printer manual, see the last page of this booklet.
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Tips for using CSW 4000 Series Printer Guide
When you can't find the information you need

» Insearching for help topics, use al three buttons at the top of Guidées
initial window: Topics, Index, and Look For.

» If yourein aseriesof stepsand want to return to the list of help topics,
dick the button marked Topics in the Guide window.

When you can't see what’s behind the Guide window

Guide windows stay in front of other windows on the screen so that your
instructions are never covered.

» Drag a Guide window by itstitle bar to move it out of the way.

» Click the zoom box once to shrink a guide window. (To expand the
window, click the zoom box a second time)

When you need more information about an instruction or term
= Click the “Huh?’ button if it is available

» |f an unfamiliar word is underlined, click it to get a definition.

Title bar

=] Zoom box

background printing

Background printing lets vou print docutnents while
VOU USe VOur commputer for other work, You turn this
feature on or off in the Chooser,

Read this information, then vou're done,

Topics button Navigation buttons

Setting Up Your Printer
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Printing

This chapter explains how to use the Color StyleWriter 4500 for everyday
tasks Before you follow the instructions in this chapter, make sure the printer
is set up and working, as described in Chapter 1

Planning documents with the Color StyleWriter 4500 in mind

Many printer options affect how much can fit on a page Before you spend a
lot of time laying out a document, set it up as you plan to print it:

1  Select the printer you plan to use.

If the Color StyleWriter 4500 is your only printer, and you followed the setup
instructions in Chapter 1, you have selected your printer. If you have access to
more than one printer, see “Switching Between Printers” later in this chapter.

2 With the document active on your computer screen, choose Page Setup from the File
menu and select the options you like.

The key areas that affect page layout are paper size, type, and orientation.

When youive finished setting your options, cick the OK button to return to
your document. You can now format it as you like Since youve already set
your printing options, the document will print as you see it on your screen.



Printing a document

The next two sections explain the different ways you can print a document:

= Quick instructions for printing standard documents. To print documents that
don't require any special options, see this section. (The section describes
what a “standard document” is)

= Detailed instructions for printing other documents. To print documents that
require any of the nonstandard options, see this section.

Quick instructions for printing standard documents

To print a standard document, follow the instructions in this section:
s Standard paper size, US Letter (85" by 11" in the United States)
= plain paper

» portrait page orientation (so when you look at the printed page, it is longer
than it iswide)

» NO special effects and normal print quality

Assuming you have already selected the printer in the Chooser as described
in Chapter 1, and that the printer isfilled with standard paper, you need only
follow these steps:

1  While the document is in an active window, choose the Print command from the
File menu.

The Print dialog box opens on your screen.
2 Make sure the printer is turned on (the green power light glows).
3 Click the Print button.

After afew moments, the document startsto print. If background printing is
turned on, you can continue working while the document is printing. You can
also monitor and control the documents that are waiting to print. (See
“Printing While You Use Your Computer” and “Monitoring and Controlling
Background Printing,” later in this chapter.)
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Detailed instructions for printing documents
If your document is not standard, follow these steps:
1  If you haven't already selected the Color StyleWriter 4500 in the Chooser, do so now.

You already selected the Color StyleWriter 4500 in Chapter 1, and if it's the
only printer you ever use, you worit need to do it again. If you do need to
switch, see “Switching Between Printers,” later in this chapter.

2  Load the paper, envelopes, or other materials into the printer, as described in Chapter 1.

Remember to adjust the external paper selector before filling the sheet feeder.

3 While the document is active on your screen, choose Page Setup from the File menu and
make adjustments in the dialog box that opens.

If the default settings shown here are satisfactory, you can skip this step.

To indicate the size

: Color Stylelliriter 4500 Page Setup | Choose the settings you
atr;1d e oftpaper o | Ponersize Paper Type: want, then click O?(. !
i € paper tray, use [ usLetter v| [ Plain Paper ] Y
ese pop-up menus. I T
. X Orientation: Scaling (%)
To print with a " ' caing (options)
PhotoGrade cartridge Two-Sided Printing:
in the prin_ter, qlick to [ Flip Horizontal [(Nome _~]
pUt an X in this box. | —{1 Use Color PhotoGrade Ink Cartridge
(Youmay alsowant || L Save as Default
to choose Photograde
from the Paper Type For manual duplex printing You can type a number from 25 to 400.
pop-up menu.) (two-sided), use this pop-up menu. Numbers smaller than 100 reduce the image;

numbers greater than 100 enlarge it.
Changing the size may change the pagination.

For more information about optional features, see “Adjusting Color Options
later in this chapter.

IMPORTANT Make sure you correctly indicate the size of the paper, envelopes,
or other material you have in the paper tray. If you change the paper sizein
this dialog box, you might also want to look over your document to see if any
of the page breaks have changed. For information on non-standard sizes, see
“Defining Your Own Custom Paper Szes” later in this chapter.

Printing
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4

Best quality takes
longer to print.
Draft is faster.

Choose Print from the File menu and make adjustments in the dialog box that opens.

To print color images — 1 print in Grayscale

in black and white
and grayscale,
click to put an X
in this box.

Chapter 2

Item in dialog box

Quality

Pages

Copies

Click the Print button.

| If you want your printed pages to be stacked
in the correct order as they come out of the
printer, click to put an X in this box.

What you use it for

Color Styleliriter 4500 | Choose the settings you
Quality: Pages: want, then click Print.
Cancel
Normal - [CR:]]]
:I > From: To: Preuieu.l)— — TO see how your_page
copies: ) will look when printed,
T Print Back to Front click Preview.

Select which level of quality you want. Generally, the higher the quality, the
longer the document will take to print. The Draft option is available only

when you use Plain paper or Transparency.

Indicate how many pages of the document to print. To print the whole
document, click All. To print a range of pages, type the beginning and end

page numbers.

Type how many copies of the document you want.

After afew moments, the document starts to print. If background printing is
turned on, you can continue working while the document is printing. You can
also monitor and control the documents that are waiting to print. (See
“Printing While You Use Your Computer” and “Monitoring and Controlling
Background Printing,” later in this chapter.)



Printing while you use your computer

Click this icon.

You can continue to work on your computer while printing on the
Color StyleWriter 4500. The feature that gives you this ability is called

background printing To turn background printing on or off, follow these steps:

Select Chooser from the Apple (@) menu.
Click the CSW 4000 Series icon in the Chooser.

If your printer is connected to your computer by a Local Talk connection kit,
click the CSW 4000 Series (AT) icon.

&

AppleShare

If you don't see the
icon, click this arrow
until it appears.

Lazer'writer

CSW 4000 . jes (AT)

Click to turn background printing on or off.

Backgmund Frinting
Sl @ on Q orf

O Active

® Inactive

Click On or Off.

AppleTalk

Click the close box in the upper-left corner of the Chooser.

Once background printing isturned on, it isin effect whenever you print,
until you turn it off. When you click Print in the Print dialog box, a message
appears for amoment to tell you the document is being prepared. Once the
message disappears, you can continue other work. Your computer may pause
occasionally while it processes the document for printing. See “Monitoring
and Controlling Background Printing,” next, for more information.

Note: Printing may be sower with background printing on. If you turn
background printing off, however, you must wait for printing to finish before
you can continue your work. Any time you print with the color PhotoGrade
cartridge on PhotoGrade paper, you should turn off background printing.

Printing
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Monitoring and controlling background printing

If you are using background printing, you can use the PrintMonitor to check
on and control your print requests. (To turn background printing on and off,
see “Printing While You Use Your Computer,” earlier in this chapter)

1 While printing is in progress, choose PrintMonitor from the Application menu.

2 2K

Hide SimpleText
Hide Others
Show AN

Finder
[ €SI 4000 Series PrintMonitor{— Choose PrintMonitor.
«4# simpleText

A window opens listing the documents that are printing or waiting to print:

e—— Pl’il'll_Ml:!nitl:lr The document that's
Printing | inti
[ LiTesler Interview @ CSw 4000 Series ——H— currently printing
Waiting
1 O, Pwr Mac systems @ CSW 4000 Series i . )
2 [, Memo @ CSW 4000 Series Documents waiting to print
=
(_cancel Printing }————— To cancel a job that's printing (or one
| Printing_Status: Tesler Interview that's waiting to print),select the job
page 1 of 4; printing 1% complete (sending data) and click here.

2 You can check the activity on your printer and cancel printing if you want to.
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Adjusting color options
To adjust the way colors are printed, follow these steps:
1  Choose Print from the File menu.

2 Inthedialog box that appears, click Options.

Color StylelWriter 4500
Quality: Pages:
®m
) From: To: Preview
copies: (IR et | ciokons
| Click Options.
[1Print in Grayscale [ Print Back to Front

3 Select your color options.

Unless you have specific needs, it may be best to leave the settings on Auto.

Color StylelWlriter 4100 Options |ﬁ| To use the CSW 4000
Intensity: Color Matching: p— ; . .
,chmvl Series Printer Guide
Halftoning: Bleed Control: Help |__onscreen h6|p, click He'D
For information on using
the Printer Guide, see
Chapter 1.

The ColorSync color-matching system makes sure that colors look as
congistent as possible no matter what device you use to view them—monitor
or printer. In addition, ColorSync helps give you the best possible colors
when you export the image to another Mac OS-based computer with
ColorSync installed or print it on another color printer.

Note: For the best color, you need to choose a specific profile for your
monitor. In the ColorSync control panel, choose the D50 profile for your
monitor. If there is no D50 available for your monitor, choose Apple Multiple
Scan 17 — D50. The D50 profile gives you better colors.

For more information on ColorSync, see Appendix C.
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Printing a photograph

Chapter 2

You can print exceptional quality photographic or other color images, using
the color PhotoGrade ink cartridge

= Use the color and color PhotoGrade cartridges to print color and black-
and-white photographs or pictures with vivid colors

» Use the color and black cartridges for black text, documents that are
mainly text, banners, and pictures other than photographs

Put paper in the lower paper tray, print side down (as usual).

If youre using Apple Color Ink—Jet Color PhotoGrade paper, the package tells
you which side to print on. You can use plain paper to print photographs. For
best results, use PhotoGrade paper.

IMPORTANT Before you print using the color PhotoGrade ink cartridge and
color PhotoGrade paper, be sure to turn off background printing. With
background printing on, the printer experiences small delays when the
computer is busy with something else The resulting print quality may not be
the best you can get from your Color StyleWriter 4500.

Turn on the printer.

The green power light should glow.



3

4

5

Open the top cover.

The carrier moves to the center of the printer. The resume light flashes

Remove the black ink cartridge.

To pop the cartridge loose,
pull its top toward you.
Then lift it out of the carrier.

Printing

35



36

Chapter 2

6

Slide the color PhotoGrade ink cartridge down into the carrier, and press it into place.

Note: The color PhotoGrade ink cartridge
includes specially formulated black and
color inks for photorealistic printing.

Close the printer’s cover.

The carrier returns to its home position on the right side of the printer, and
the resume light stops flashing.



Click to put an X

Choose Page Setup from the File menu.

Color Stylelllriter 4500 Page Setup

Paper Size: Paper Type:
[_US Letter v]
Transparency
Orientation: Coated Paper

Cancel

1 Glossy
@ Tu PhotoGrade

None v|

[ Flip Horizontal

in this box. _l_z use color PhotoGrade Ink Cartridge

10

[ Save as Default

Choose Print from the File menu.

In the dialog box that appears, click Print from the File menu.

| Choose the settings you

want, then click OK.

Choose the paper that
Suits your purposes.
For the best quality,
put PhotoGrade paper
into the paper tray
and choose it here.

The document containing the photographs beginsto print. It may take several

minutes before you can see the results.

When you're done printing photographs

Take the time to reset the printer for normal printing. Here are some settings

to remember:

= Take the color PhotoGrade ink cartridge out of the printer, put it into the
storage case, and put the black ink cartridge back into the printer.

= Inthe Page Setup dialog box, change Paper Type back to Plain Paper (if
that's what you plan to use next). Click the Use Color PhotoGrade

Cartridge checkbox to remove the X.

» Remove any special paper from the lower paper tray, and replace it with

plain paper.

Printing ‘
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Printing a banner

For the best results, use Apple Color Ink—Jet Banner Paper. If you use
continuous computer paper or Z-fold paper instead, 20-pound paper is best.

1  Choose Page Setup from the File menu.
2 Inthe Page Setup dialog box, choose either Banner US Letter or Banner A4 from the
Paper Size pop-up menu.
Color StylelWriter 4500 Page Setup | Choose the settings you
Paper Size: Paper Type: want, then click OK.
—Banner US Letter
0 Us Legal Scaling (%)
Choose one of the __| Executive
i A4 Two-Sided Printing:
banner paper sizes. | Banner f4
O ns _.I_
O B5-JIs nk Cartridge
_D No. 10 Envelope
| CoEnvelope
DL Envelope

Chapter 2

A2 Envelope

US Card 446
US Card 5u8
A6 Card

Hagaki Card

Add Custom...
Edit Custom...

Note: For information on the sizes
of the banner papers (in inches and
millimeters), see Appendix A.



3

4
5

6

Slide the paper selection lever to the right until it clicks into place.

Anicon on the lever indicates that this is the setting for banner paper.

Paper selection lever ‘

Remove all paper from the lower tray.

Flip up the banner support in the upper tray.

Flip up the banner support.

Estimate how many sheets your banner needs to print.

Printing
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Using the application that created the banner, you should be able to tell
whether the banner will cover three sheets or four sheets, for example The
printer prints a maximum of 20 sheets in one banner.

From a stack of Z-fold banner paper, tear off at least one sheet more than you need to
print the banner.

Tear off the perforated strips, if any, and then unfold and refold the stack to make sure
pages don't stick together.

Put this edge into the paper tray first, at the top of the stack

Put the paper in the lower paper tray, with a torn edge at the top of the stack, facing
lengthwise into the printer.

Slide the paper adjusters so they touch the edges of the stack of paper.



11  Make sure the banner document is the active window on the screen, and choose Print
from the File menu.

12  Inthe dialog box that appears, click Print.

13 When printing stops, press the Resume button as many times as necessary to advance
the remaining banner paper out of the printer.

When you're done printing banners

Take the time to reset the printer for normal printing. Here are some steps to
remember:

In the Page Setup dialog box, select the Paper Size appropriate for the
document you want to print next.

Side the paper selection lever to the left. (The lever islocated underneath
the left corner of the lower paper tray)

Lower the banner support in the upper tray.
Put some paper into the lower paper tray.

Printing
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Printing envelopes

If youre printing a single envelope, use the single-envelope dot (and leave the
paper in the paper tray). If youre printing a stack of envelopes, use the

paper tray

Notes about envelopes

See the instructions that came with the applications you use to see if they
offer special, easy ways to format and print envelopes. If not, choose the
envelope size youre using in the Page Setup dialog box and format the
envelope text as you like

IMPORTANT The Color StyleWriter 4500 cannot print flush with the left edge,
so return addresses may print closer to the center than you like To avoid this,
use envelopes preprinted with your return address, or put the address on a
label or arubber stamp.

Single business-size envelopes
1  Choose Page Setup from the File menu.

2  Inthe Page Setup dialog box, choose either No. 10 Envelope or DL Envelope from the
Paper Size pop-up menu.

Color StylelWriter 4500 Page Setup | Choose the settings you
Paper Size: Paper Type: want, then click OK.
Banner US Letter
ori¢ US Legal Scaling (%):
Executive
A4 Two-5Sided Printing:
O as
O Ba-JIs nk Cartridge
O
No. 10 Envelope
Choose No.10 —_{Eﬁ Envelope
Envelope DL Envelope
or DL Envelope. A2 Envelope Note: For information on the sizes
US Card 446 of the envelgpes (ininches and millimeters),
US Card 518 see Appendix A.
A6 Card
Hagaki Card
Add Custom...
Edit Custom...
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3

Slide an envelope into the single-envelope slot until it stops.

Load the envelope print side
down, with the flap against
the right side of the printer.

IMPORTANT Make sure there
is paper in the tray.

Choose Print from the File menu.

If you are using an application that includes settings for printing envelopes,
follow the applicatioris instructions for setting up the address and placing the
envelope in the printer.

In the dialog box that appears, click Print.

Printing
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A stack of envelopes

1  Choose Page Setup from the File menu.

2  Inthe Page Setup dialog box, choose the envelope you're printing from the Paper Size

pop-up menu.

Color StylelWriter 43500 Page Setup | Choose the settings you

Paper Size: Paper Type: want, then click OK.
Banner US Letter

oriy US Legal scaling (%):
Executive
A4 Two-Sided Printing:

O as

O Bs-dis nk Cartridge

n No. 10 Envelope

Choose the envelope L6 Envelope
- DL Envelope . . .
you are printing. A2 Envelope Note: For information on the sizes
of the envelopes (in inches and millimeters),

Us Card 446 .
US Card 548 see Appendix A.
A6 Card
Hagaki Card
Add Custom...
Edit Custom...

3 Slide the paper adjusters out as far as you can.

Width adjuster

The paper tray

Length adjuster

should be empty.

Chapter 2



4

5

Put a stack of up to 20 envelopes in the printer.

If the envelopes are thick, reduce the number in the stack.

Load the envelopes print side
down, with the flap against the
side of the printer.

Printing
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If youre printing small, invitation-size envelopes (such as A2 or C6), you may
have to lower the handle on the length adjuster so you can dide it far enough
under the upper paper tray.

To release the handle so
you can lower it, squeeze
the lower inside surface.

Choose Print from the File menu.

If you are using an application that includes settings for printing envelopes,
follow the application's instructions for setting up the address and placing the
envelope in the printer.

In the dialog box that appears, click Print.

When you're done printing envelopes

Take the time to reset the printer for normal printing. Here are some steps to
remember:

= In the Page Setup dialog box, select the Paper Sze appropriate for the
document you want to print next.

s Remove any unused envelopes and make sure there is paper in the lower
paper tray.



Printing transparencies

For best results, use Apple Color Ink-Jet Transparency Film or transparencies
designed for ink-jet printers

1  Choose Page Setup from the File menu.

2 Inthe Page Setup dialog box, choose Transparency from the Paper Type pop-up menu.

Choose Transparency.
Color Styleliriter 4500 Page Setup | Choose the settings you
Faper Size: Faper Type: want, then click OK.
[ US Letter «| [~Plain Paper

Transparency .
Orientation: Coated Paper

Giossy

Tw{ Photobrade

[ Flip Horizontal
[Juse Color PhotoGrade Ink Cartridge
[ save as Default

3 Choose Print from the File menu.

4 Inthe Print dialog box that appears, choose Best from the Quality pop-up menu.

Color StylelWriter 4500

Choose Best. __|

Copies:

[ Print in Grayscale

_
) From: To: Preview
O Print Back to Front

Printing
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5

Insert the transparencies into the paper tray, shiny side down, with the joined edge into
the paper tray first.

Load transparencies with the
shiny side down. The edge
where the paper and
transparency are joined should
go into the paper tray first.

Single layer trasparency

Paper-backed transparency

Slide the paper adjusters in so they touch the edges of the stack.
Choose Print from the File menu.
In the dialog box that appears, click Print.

I'n printing transparencies, the printer uses more ink, putsit on the
transparency surface more dowly, and allows more time for inks to dry
between sheets For these reasons, transparencies take a while to print.

When you're done printing transparencies

Take the time to reset the printer for normal printing. Here are some steps to
remember:

= Inthe Page Setup dialog box, select the Paper Type appropriate for the
document you want to print next.

= Remove any unused transparencies and put some paper into the lower
paper tray.

= Next time you print, remember to change the print quality back to Normal
(or whatever is appropriate) in the Print dialog box.



Printing labels

Choose US Letter
(or A4) and
Plain Paper.

For printing labels,
use Normal print
quality.

For best results, use labels designed for ink—jet printers

Choose Page Setup from the File menu.

In the Page Setup dialog box, choose US Letter or A4 from the Paper Size popup menu,
and choose Plain Paper from the Paper Type pop-up menu.

Color Stylelldriter 4500 Page Setup
Paper Size: Paper Type:
[ usLetter w| [ Plain Paper w]
T T

Orientation: Scaling (%):
H Two-5ided Printing:

[ Flip Horizontal
[Juse Color PhotoGrade Ink Cartridge
[ save as Default

Cancel

| Choose the settings you
want, then click OK.

Choose Print from the File menu.

In the Print dialog box that appears, choose Normal from the Quality pop-up menu.

Color StylelWriter 4500 -

Quality: Pages:
Normal v | @ Al ance

O From: To: Preview

Copies: ::

[1Print in Grayscale [ Print Back to Front

| Choose the settings you
want, then click Print.

Printing
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5  Fan the edges of the label sheets to make sure they are separated.

6 Insertinto the paper tray sheets of labels, face-down, on top of about 5 sheets of plain
paper that's the same size.

You can insert up to 25 sheets of labels

Labels, face-down

Plain paper (5 sheets)

7  Slide the paper adjusters in so they touch the edges of the stack.
8  Choose Print from the File menu.
9 Inthedialog box that appears, click Print.

When you're done printing labels

If you expect to print on plain paper next, you can leave the print settings as
they are
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Printing index cards and postcards

You can use the Color StyleWriter 4500 to print on index cards and postcards.

1  Choose Page Setup from the File menu.

2 Inthe Page Setup dialog box, choose the card size you want from the Paper Size pop-up
menu, and choose Plain Paper from the Paper Type pop-up menu.

Color StylelWriter 4500 Page Setup

ori

Choose the size that
matches the cards
you are printing on.

600

Paper Size:

v US Letter

Banner US Letter
US Legal
Executive

A4

Banner A4

A3

B3-JIS

No. 10 Envelope
C6 Envelope
DL Envelope
A2 Envelope

| Choose the settings you
Faper Type: want, then click OK.
Plain Paper Cancel

Scaling (%)
Two-Sided Printing:

None hd

nk Cartridge

US Card 4ub
Us Card 548
A6 Card

Hagaki Card

Add Custom...
Edit Custom...

Note: For information on the sizes
of the cards (in inches and millimeters),
see Appendix A.

3 Remove the upper tray and raise the card guide.

Remove the upper tray.

Printing
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4 Place a stack of up to 30 cards in the lower paper tray, resting against the raised card
guide.

5 Lower the handle on the paper length adjuster.

To release the handle so
you can lower it, squeeze
the lower inside surface.

6  Slide the paper adjusters in so they touch the edges of the stack.
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Replace the upper tray and raise the card guide.

You may need to lift the printer cover for easy access

Choose Print from the File menu.

When you're done printing index cards or postcards

Take the time to reset the printer for normal printing. Here are some steps to
remember:

= In the Page Setup dialog box, select the Paper Sze appropriate for the
document you want to print next.

» Remove the top tray, then remove any unused cards and lower the
card guide

» Replace the top tray and make sure there is paper in the lower paper tray.
» Raise the paper adjuster handle back to its vertical postion.
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Two-sided printing

Chapter 2

To conserve paper, you can print on both sides, putting the paper through the
printer twice The first time through, the printer prints odd-numbered pages;
the second time through, it prints even-numbered pages.

Note: Use 28-pound or heavier paper for two-sided printing. If you use a
lighter paper, the ink may bleed through the paper.

Put paper in the lower paper tray.
Remove any paper from the upper tray.
Choose Page Setup from the File menu.

Choose Book or Tablet from the Two-Sided Printing pop-up menu, and click OK.

Book prints the pages so

Two-Sided Printing:

S None ‘I they can be bound on the
[ Flip Horizontal |eftl as a book.
g;’:z::'s";:f';tl':mde Ink|_Tablet J Tablet prints the pages
so they can be bound at
the top, as a tablet.

Color StylelWriter 4500 Page Setup | Choose the settings you

Paper Size: Paper Type: want, then click OK.
[US Letter ]| [ Plain Paper A '

Orientation: Scaling (%)

Choose Print from the File menu.

The printer automatically prints the odd-numbered pages and delivers them
in the upper paper tray.

Following instructions on the screen to bring PrintMonitor to the front, choose
PrintMonitor from the Application menu.



6

Following instructions on your screen, put the stack of printed pages back into the lower

paper tray.

The odd-numbered pages of your document have
been printed and are in the 0UT tray. To print the
even-numbered pages of your document:

* Remove the printed pages from the OUT tray.

* Turn the stack of pages around 180 degrees,
keeping the printed side up.

* Insert the stack into the IN tray with the top
of the pages towards the printer.

Take the printed sheets out, rotate the stack, and
insert it into the lower paper tray, with the printed
side up. The second side will be printed according
to what you chose (Book or Tablet) in step 3.

When the paper is ready, click OK.

When you're done with manual duplex printing (two-sided)

Take the time to reset the printer for normal printing. In the Page Setup dialog

box, choose None from the Two-Sded Printing pop-up menu.

Printing
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Printing a flipped document

Click to put an X

in the box. | ] Flip Horizontal

Chapter 2

You can flip a document, reversing text and pictures so they are correct when
you transfer the image to another surface (such as a T-shirt). Flipping can also
be useful when you print transparencies. (You can write on the transparency
without smearing the ink printed on the reverse side)

Put paper in the lower paper tray, print side down (as usual).
If youre using transparencies, put them in rough side down.
Choose Page Setup from the File menu.

Click Flip Horizontal and click OK.

Orientation: Scaling (%):

Two-5ided Printing:

Color StylelWriter 4500 Page Setup -_--m | Choose the Settings you
Paper Size: Faper Type: want, then click OK.
[ usLetter +] [ Plain Paper |

[Juse Color PhotoGrade Ink Cartridge
[ save as Default

Choose Print from the File menu.
In the dialog box that appears, click Print.

The text and pictures print backwards. To see the reverse image, hold the page
up to amirror.

When you're done printing flipped documents

Take the time to reset the printer for normal printing. Here are some steps to
remember:

= In the Page Setup dialog box, click Flip Horizontal to remove the X from
the checkbox.

» If you used transparencies or special paper, replace it with standard paper
in the lower paper tray.



Defining your own custom paper sizes

Occasionally, you may want to print on paper whose size does not appear in
the Paper Size menu on the Page Setup dialog box. If the size of the paper
falls within these ranges, you can use it:

Width: 5to 85 inches
Length: 583 to 14 inches

To print on the nonstandard paper, follow these steps:
1  Putthe paper lengthwise into the lower paper tray.

For easier access, you can remove the upper paper tray, and then put it back
when the paper isin place

If the paper is shorter than

8.6 inches, squeeze the handle
so you can lower it before you
push the adjuster against the
stack of paper.

Printing
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2  Choose Page Setup from the File menu.
3 Choose Add Custom from the Paper Size pop-up menu.

4 Inthe dialog box that appears, type the appropriate information and click OK.

Please enter your custom media size:

Specify the size in Name: Generic Custom Size | Give the custom size
inches or

aname.
i @ Inch Width: Height: . .
centimeters. 4’«;) e ere o m Type the width and height.

If you are printing —Ul T envelope

Tonstandard | When you're ready,

click OK.
envelopes, click to
put an X here

5  Choose Print from the File menu.
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Tips on Paper, Quality, Speed, and Cost

This chapter explains how to use different materials and printing options to
meet your needs

Choosing print materials

Here are some tips on when and how to use different print materials.

Plain paper

Use plain paper for everyday printing.

= Print quality may vary depending on the manufacturer of the paper.
If youre not happy with one kind of paper, try a different brand. For
consistent results, use one of the special papers designed for the
Color StyleWriter 4500 printer.

= You can use any plain paper, including plain copier paper. Paper weight
can range from 16 to 36 pounds, though 20-pound paper is recommended.

= Dorit use erasable typing paper, damaged or wrinkled paper, stapled paper,
or multipart forms (“carbonless carbons’).

= Plain paper amost always has one side that is better for printing than the
other. See the package label to determine which side is better, and load that
side face down in the lower paper tray.
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Apple Color Ink-Jet Premium Coated Paper

This bright white coated paper is great for creating high-quality
presentations, newd etters, and reports

= Useonly coated paper designed for use with the Color StyleWriter 4500.

= One side of the paper is alittle whiter than the other and is better for
printing. See the package label on the coated paper to determine which
sdeis better, and load that side face down in the lower paper tray.

Apple Color Ink-Jet Glossy Paper

This glossy, heavyweight paper produces vibrant, permanent color images.
= Use only glossy paper designed for use with the Color StyleWriter 4500.

= When loading a stack of glossy paper into the paper tray, put a single sheet
of plain paper at the bottom of the stack to prevent misfeeding.

Apple Color Ink-Jet PhotoGrade Paper
Use this heavyweight, photo-quality paper together with the color Photograde
ink cartridge for printing photorealistic images.

= Use only PhotoGrade paper designed for use with the Color StyleWriter
4500.

= Load the PhotoGrade paper so that the shiny side is face down in the lower
paper tray.



Apple Color Ink-Jet Banner Paper

Use this paper to print a continuous document that contains pages strung
together—for example, a birthday greeting.

= Use only banner paper designed for use with the Color StyleWriter 4500.

= When loading a stack of banner paper into the paper tray, make sure the
torn edge at the top of the stack goes into the paper tray first.

Apple Color Ink-Jet Transparency Film
This fast-drying, smudge-proof transparency film is great overhead
presentations.

= Use only transparencies designed for use with the Color StyleWriter 4500.
These special transparencies may have a sheet of paper attached to them or
astrip of tape at one end; leave the paper and the tape attached until after
printing.

» Load the transparencies so that the paper backing or the tape strip is face
up in the lower paper tray and the edge where the paper and film are
joined or the taped edge goes into the tray first.

Labels

Use labels for addressing envelopes and other purposes.
» Use only labels designed for use with ink jet printers.

» Load the labels face down in the lower paper tray. Put about 5 sheets of
plain paper under the stack of labels.

Index cards and postcards

Use index card or postcard stock when you want to print small messages, send
greetings, post information on bulletin boards.

» Load the cards so that the side you want to print on is face down in the
lower paper tray.

Tips on Paper, Quality, Speed, and Cost
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Materials you can print on

Here are details about the kinds of materials you can use in your

Color StyleWriter 4500 printer.

Print material
Plain paper

Coated paper

Index cards

Glossy paper

Color PhotoGrade paper

Transparencies

Banner paper
(continuous computer
paper or Z-fold paper)

Envelopes

Labels

Special instructions

= Use 16- to 36-pound paper.

= Use only paper designed for this printer.
= The whiter side should face down.

= The print side should face down.

= Use only paper designed for this printer.
= The shinier side should face down.

= Use only paper designed for this printer.
= The shiny side should face down.

= Use only transparencies designed for this printer.

= The transparency may have a paper backing or a
paper tape on one edge. The paper or the tape
should face up going into the printer.

= The edge where the paper and transparency are
joined or the taped edge of the transparency should
go into the paper tray first

= Use plain paper banner paper.

n If there are perforated strips, tear them off.

= Atorn edge at the top of the stack should go
into the printer first.

= Make sure the envelope flap is folded down flat.

= To prevent misfeeds, put about 5 sheets of plain
paper under the stack of labels you insert.

= Put the labels in the tray face down.

= In the Print dialog box, choose Plain from the
Media pop-up menu.

For more information about paper sizes and specifications, see Appendix A

and Chapter 2.



Quiality

Select Best quality. —

Best quality takes
longer to print, but
you get better
quality—even on
plain paper.

For highest-quality printing of photographs or images, choose Best quality,
use the color PhotoGrade ink cartridge and print on PhotoGrade papers.

Color StylelWriter 4500
3 From: To: Preview

Copies:

[ Print in Grayscale [ Print Back to Front

Also use the following selections in the Color Options dialog box. (To display
the dialog box, click the Color button in the Print dialog box.)

Color Stylelriter 4500 Options

Intensity:

Halftoning:

Color Matching: y #
l—lﬂuto - Cancel
Bleed Control: Help

For the best color
printing, choose
ColorSync from the Color
Matching pop-up menu.

For the best color, you need to choose a specific profile for your monitor. In
the ColorSync control panel, choose the D50 profile for your monitor. If there
isno D50 available for your monitor, choose Apple Multiple Scan 17 — D50.
The D50 profile gives you better “warm’ colors

For the best visual match between the colors on your monitor and printed
colors, select the Page-White Gamma option in the Monitors control panel.
(On some computers, the control panel is called Monitors & Sound.) To select
a gamma option, open the Monitors control panel, then hold down the Option
key while you dlick the Options button. In the Options window, click the Use
Special Gamma checkbox to put a check init. Then choose Page-White

Gamma from the menu.

On a multiscan monitor, make sure that the color temperature, or intengity, is
set to 9300 K (the default setting). See the monitor manual for instructions. If
you select the Page-White Gamma option with a color temperature other than
9300 K, your monitor colors could look too red or too blue compared to

printed colors.

For more information, see “Adjusting Color Options’ in Chapter 2.
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Speed

For faster printing, change the Print Quality setting in the Print dialog box.
(To display the dialog box, choose Print from the File menu)

Color Stylelriter 4500

Quality:

Select Normal or |

Draft. Draft is faster
than Normal.

Cost

Chapter 3

Copies: _I

[JPrint in Grayscale

o From: To: Preview
(options ]
[J Print Back to Front

Color printing takes longer than black-only printing.

To reduce the amount of ink you use, select Draft quality in the Print dialog

box whenever possible

For smple graphics or for documents that are mostly text, use the color and
black ink cartridges. The color PhotoGrade cartridge should be used in place
of the black cartridge only when you need the best quality photorealistic

color printing.




Maintaining Your Printer

It doesrit take much effort to keep your Color StyleWriter 4500 printer in
good working condition. You smply have to replace the ink cartridges when
they run out of ink and clean the printer or print head if you notice a
problem. (For instructions on cleaning the print head, see “ Cleaning the
cartridges’ in Chapter 5)

For other service, see the information about service and support that comes
with your Color StyleWriter 4500.

IMPORTANT Follow all the safety instructions given at the beginning of
Chapter 1

Replacing ink cartridges

Look carefully at your printed documents to seeif acolor is missing or faded.
Sometimes it's obvious—such as when you run out of black ink. At other
times you may notice that the colors seem wrong—such as when youre
printing a nature scene and you run out of yellow.

The best way to verify that ink isrunning low is to print the sample page
(For details, see “Printing the Sample Page’ in Chapter 1)

For instructions on replacing an ink cartridge, see “Installing the Ink
Cartridges’ in Chapter 1
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Cleaning the outside of the printer

Chapter 4

Before you clean the printer, turn it off and unplug the power cord. Then
wipe the outside of the printer with a clean, soft cloth dampened with water.
If necessary, you can use amild soap or detergent. Be careful not to get any
liquid in the power cord receptacle

WARNING Donit use ammonia-based or alcohol-based cleaners on or
around the printer—they may react with the plastic.



Troubleshooting

This chapter provides solutions to some problems that you may encounter
while using your Color StyleWriter 4500 printer.

As long as you follow the maintenance instructions in Chapter 4, youre not
likely to have any problems with your printer. The most common source of
trouble is faulty software installation. To avoid these problems, follow the
software installation instructions in Chapter 1

WARNING If you have a problem with your Color StyleéWriter 4500 printer
and nothing presented in this chapter solvesit, conault the service and
support information that came with the printer for instructions on how to
contact an Apple-authorized service provider or Apple for assstance If
you attempt to repair the Color StyleWriter 4500 yourself, any damage
you may cause to the printer will not be covered by the limited warranty
on your printer. Contact an Apple-authorized dealer or service provider
for additional information about this or any other warranty question.
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Safety precautions
To prevent damage to the Color StyleWriter 4500 printer and harm to yourself
and other users, follow these safety tips

= Dorit touch anything inside the printer except as described in the
instructions in this manual. Otherwise, you may damage delicate
mechanical parts

= Dorit shake ink cartridges Ink can leak out and cause stains
= Dorit touch the ink opening on an ink cartridge

= Dorit oil theingde of the printer.

= Dot attempt to disassemble the printer.

= Before you unplug the printer, make sure it is turned off. (The green power
light should be off)) Turning the power off ensures that the carrier has
returned securely to its home position and the cartridges have been capped.

The Chooser doesn’t show the Color SW 4000 Series icon

If you open the Chooser and don't see the Color SW 4000 Seriesicon, you
probably need to install the appropriate printer software. For instructions, see
“Installing Your Printer Software’ in Chapter 1

Also, make sure the QuickDraw GX software is turned off. You can remove it
from the Extensions folder or use the Extensions Manager to turn it off.

Installation is unsuccessful

If a message tells you that installation was not successful, check to make sure
you turned off virus-detection software as explained in Chapter 1 If that
doesnt work, try removing corrupted fonts, as described in the next section.
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Removing items from your Fonts folder to solve installation problems

Itemsin your current Fonts folder can interfere with successful installation of
the printer software To correct the problem, follow these steps:

Quit all programs you are currently running.
Open the Fonts folder (inside the System Folder) on your computer.

Drag the following files out of the Fonts folder. (Look for files with exactly these names.)
= Avant Garde

= Bookman

= Delphian

= Garamond Narrow

= Helvetica Black and Helvetica Compressed
» Lubalin Graph

= LucidaBright

= Machine

= N Helvetica Narrow

= Nadianne

= New Century Schibk

= Old English Text

= Onyx

= Oxford

= Swing

» Zapf Chancery

» Zapf Dingbats

= Zed

You can put the fonts temporarily into a new folder and drag the folder to
your desktop. Then, after you install the Color StyleWriter 4500 software
(including these fonts), you can drag the temporary folder to the Trash.

Repeat the software installation procedure in Chapter 1.

For more details about fonts, see Appendix B.

Troubleshooting
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The computer crashes while attempting to print

When a computer suddenly stops working—either a message on the screen
tells you a system error has occurred, or the mouse and keyboard act as if
they're disconnected—the computer has crashed.

If your computer often crashes after you tell it to print a document, your
printing software may have become corrupted. Reinstall the printer software
by following the instructionsin “Installing Your Printer Software’ and
“Telling Your Computer to Use the Color StyleWriter 4500” in Chapter 1

The computer doesn’t recognize the Color StyleWriter 4500

Chapter 5

If you have selected the Color StyleWriter 4000 Series icon in the Chooser
but nothing prints, or you get a message that no Color StyleWriter 4500 is
connected, one of the conditions in the list that follows may be the cause

Note: Before you try to solve the problem, choose CSW 4000 Series
PrintMonitor from the Application menu to see if there are any error
messages and to check how many print requests are waiting. If you repeatedly
tried to print a document, there may be multiple copies waiting to print. You
can delete anything you dorit want by sdlecting itstitle, and then dicking the
Cancdl Printing button. See “Monitoring and Controlling Background
Printing” in Chapter 2.

= A plug may be loose To make sure that all cables are securely connected,
turn off the computer and the printer, then unplug each end of each cable
you want to test and plug it back in. For connection instructions, see
Chapter 1

= You may have indicated the wrong port in the Chooser. Open the Chooser
and change the port selection. (Look at the back of the computer to see
whether you plugged the printer into the computer’s printer port [&] or
modem port [%])

» |If your computer is not connected to a network, turn off AppleTalk in
the Chooser.



» If you are trying to use a printer on a network, and the printer name isrt
listed in the Chooser, make sure that the printer is turned on and
connected to the network. Then try again to select the printer in the
Chooser.

» If the printer is connected to a Local Talk network, select the CSW 4000
Series (AT) in the Chooser, and make sure that AppleTalk is active (The
“AT” in the driver name stands for AppleTalk.)

» If the printer is on aLocal Talk network, someone may have given it a new
name

= You may be using the wrong printer software Make sure you installed the
software as described in Chapter 1 and that you have selected the printer as
described in “Telling Your Computer to Use the Color StyleWriter 4500,
also in Chapter 1

= If youre using a PowerBook computer with an internal modem, change the
serial port setting to Normal or External. For details, see “ Special
Information for PowerBook Owners’ in Chapter 1

= The printer may need to be reset. Turn the printer off, count to five, then
turn it back on.

If you still carit resolve the problem, the printer may not be working properly.
See the information about service and support that came with your printer.

A PowerBook has trouble printing to the Color StyleWriter 4500

Some PowerBook computers have special requirements for printing. See
“Special Information for PowerBook Owners’ in Chapter 1

Troubleshooting
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The lights indicate a problem

Chapter 5

Sometimes the lights on the printer signal a problem.

Both lights are off.

= The printer is turned off. Press the power button. If you still dorit see the
glowing green light, make sure the printer is plugged into a power outlet
and that the outlet has power.

Both lights blink.

» Paper may be jammed in the printer. Open the front cover and remove any
jammed paper. To advance paper that is part way through the printer, press
the resume button. Close the front cover and turn the printer off, then on
again.

» Theink-cartridge carrier may be jammed. Close the front cover, turn the
printer off, then on again.

The power light blinks, and the resume light is off.

= Thisisnormal behavior when the printer is receiving data, printing, or
waiting for ink to dry.



The power light glows steadily, and the resume light blinks.

= One or both of the ink cartridges may not be seated properly, or you may
have forgotten to remove the tape from a new cartridge Open the front
cover. Remove both cartridges. Holding the black plastic sides of the
cartridge, check to be sure the tape has been removed from the print head.
Then replace the cartridges in the carrier. Make sure each cartridge is
pressed all the way into the carrier. If acartridge feels at all l0osg, it is not
properly seated. For instructions, see “Installing the Ink Cartridges’ in
Chapter 1

= Thefront cover may be open. Make sure it is closed.
= There may be no paper in the lower paper tray. Load paper.

= If you just printed a banner, you need to unload the remaining banner
paper. Tear off the unused paper in the tray. Then press and release the
resume button to advance the end of the banner through the printer.

= The printer may be confused. Press and release the resume button.

The printer seems slow
See the suggestions under “Speed” in Chapter 3

Paper is jammed

Occasionally a piece of paper may get stuck inside the printer during the
printing process. To clear a paper jam, follow these steps:

1  If necessary, open the front cover to see where the jam is.
2 Gently pull the paper free.
3 Toadvance any remaining paper, press and release the resume button.

4 Turn off the printer, then turn it on again.

Troubleshooting
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Paper or envelopes feed improperly
If paper tears, gets skewed, or comes through the printer crumpled, it may not
be entering the printer properly. Try the following:

= Make sure you have loaded the paper correctly, paying special attention to both
paper adjusters.

For instructions on loading paper, see “Loading Paper into the Paper Tray
in Chapter 1

= Do not overload the paper tray.

If you use heavier paper, fewer sheets will fit in the paper tray.
m Do not force paper into the paper tray.
= Try to remove any torn or damaged pieces of paper from the printer.
See “Paper |Is Jammed,” earlier in this chapter.
Take the paper out of the paper tray and check it.

Make sure none of the sheets is curled, bent, or dog-eared.
Make sure the edges of the stack line up evenly.

Make sure the paper adjusters arent too snug or too loose The stack
should lieflat (not bowed).

Load either envelopes or paper (not both) into the paper tray.

Make sure you have inserted envelopes correctly. The flaps should lie flat
agai nst the envelope, the edges should be smoothed flat, and no air should
be trapped in the envelopes.

When loading transparencies, the side with the tape or the paper backing
should face up. The taped edge or the edge where the paper and the
transparency are joined should go into the paper tray first.
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The Color StyleWriter 4500 won't print a particular document

If you attempt to print a document and no page is printed—not even a blank
one—try the following:

Check for messages on your computer screen. Also, choose CSW 4000
Series PrintMonitor from the Application menu.

Your computer may be low on memory. See “Memory IsLow,” later in this
chapter.

Turn the printer off, then on again. (This resets the printer)
Repeat the printing process

Sometimes problems disappear when you try to print your document again.

Printing problems can often be caused by errorsin your applications. If
you can print from the SimpleText or TeachText application but not from
another application, it's probably a problem with that application. Contact
the publisher of that application for help.

Restart your computer.

The printer acts as if it's working, but nothing is printed on the page

If your printer takes the paper, but doesnt actually print anything, try the
following:

If theink cartridge is hew, make sure that you removed the tape from its
print head.

Make sure the ink cartridges are correctly installed. (For instructions, see
“Installing the Ink Cartridges’ in Chapter 1)

The printer may be out of ink, or the cartridges need to be ceaned. You
can check by seeing whether the sample page prints. See “Printing a
Sample Page’ in Chapter 1 For instructions on cleaning the cartridges, see
“Cleaning the Cartridges” later in this chapter.

Troubleshooting
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Messages appear on your computer screen

Memory is low

Chapter 5

M ost messages that appear on your screen are self-explanatory. For example,
they may tell you that the printer is out of paper or that the paper is jammed.
Once you correct the problem, the message goes away.

These messages usually mean what they say. Occasionally they appear when
you have the wrong port indicated in the Chooser. See “ Telling Your
Computer to Use the Color StyleWriter 4500” and “Special Information for
PowerBook Owners’ in Chapter 1

Oncein awhile, your computer may be temporarily low on random-access
memory (RAM).

Symptoms that indicate a memory problem:

= Some documents do not print.

= Some text incorrectly appears in the Geneva font.

» Characters look jagged.

= An “out of memory” message appears on your screen.

If you have a memory problem, try the following:
= Run only one program at atime; quit the ones youre not using.

= |f memory has been severely fragmented, you should quit all open
applications, then reopen just the one youre using.

= Increase the amount of memory you give to the program youre printing
from by using the Get Info command (as explained in the instructions that
came with your computer)

= Turn off background printing. See “Printing While You Use Your
Computer” in Chapter 2.

= In the Page Setup dialog box, choose Portrait (normal) orientation instead
of Landscape (sideways) orientation.

» Print color documents using “Print in Grayscal€’ in the Print dialog box.
Printing in grayscal e takes the least memory.



= Turnon virtua memory in the Memory control panel. Virtual memory is
described in the instructions that came with your computer. (Note: Using
virtual memory can dow down your computer.)

= Obtaining additional RAM for your computer can solve some of these
problems and improve printing speed.

» Restart your computer. Some software applications retain memory
resources even after you have quit the application. The only way to recover
this memory isto restart.

Documents did not print as expected

If the quality of printing is OK—not smeared or incomplete—but the result is
not as you expected, you may have made a mistake in using the printer
software. For example, in the Page Setup dialog box, someone might have
checked “Save as Default.” If it is checked, and you are not getting the results
you expect when you print, click the checkbox to remove the X. Make sure
the settings in Page Setup are what you want, and then try printing again.

For additional help, read the subsections that follow for suggestions

Text appears in the Geneva font or prints jagged

When your computer is low on memory, it may display and print certain fonts
in the Genevafont. (Geneva looks like this.) Some text may also have jagged
edges. To fix low-memory problems, see the preceding section, “Memory

Is Low”

For more information about fonts, see Appendix B, “Using Fonts With the
Color StyleWriter 4500

Some rotated text may print jagged if you apply a style that has not been
defined for the font. Try applying plain style to the text.
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Graphic images don't print or appear jagged

Some advanced page layout and art applications use the PostScript page
description language, a language that the Color StyleWriter 4500 does not
understand. As long as your applications have a PICT preview option, you can
print the file on a Color StyleWriter 4500, but the image may appear jagged.
Also, images saved as encapsulated PostScript (EPS) may appear jagged on all
non-PostScript printers. Whenever possible, use a TIFF or PICT version of
theimage

Page breaks change unexpectedly

Most applications determine where to break pages by eval uating the
information you provide in the Page Setup dialog box. Also, different types of
printers space text in dightly different ways. The following actions can cause
page breaks to change:

= changing from one type of printer to another

» changing the paper size in the Page Setup dialog box
= scaling the document in the Page Setup dialog box

» changing the orientation in the Page Setup dialog box

It's best to choose the printer you want and the Page Setup options you need
before working on your page breaks

A page prints off center

This problem may result from one of the following conditions:
= You have selected the wrong paper size in the Page Setup dialog box.
= The margins are set incorrectly in the document you are printing.

= Paper is not placed properly in the paper tray. See “ Paper or Envelopes
Feed Improperly;,” earlier in this chapter.



Text lines up in columns on the screen but not when it prints

You may have used spaces (rather than tabs) to line up the text. Because
printers interpret spaces differently than the screen does, the text may fail to
line up when you print it. Try replacing the spaces with tabs.

You can also make columns by using spaces with a monospace font—such as
Courier or Monaco—instead of tabs. A monospace font is one in which every
character has the same width.

Everything prints backwards

Choose Page Setup from the File and see whether therés an X in the “Flip
Horizontal” checkbox. If so, click to make the X disappear.

Print quality is poor
Most image problems are caused by problems with an ink cartridge or with
your choice of paper. Don't use the following types of paper:
= erasable typing paper
» damaged, wrinkled, or stapled paper
= Multipart forms (“carbonless carbons’)
= glossy paper, unlessits especially designed for StyleWriter printers
For best print quality, use coated, glossy, or PhotoGrade paper. If you use
plain paper, use 16- to 36-pound copier paper; 20-pound paper is

recommended. Plain papers can vary widely. If youre not happy with one
kind of paper, try a different brand.
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The image is too light or too dark

If printing looks fuzzy because it's too light or too dark, try the following:

= Clean the cartridges See “ Cleaning the Cartridges,” later in this Chapter. If
this doesrit help, replace one or both ink cartridges See “Installing the Ink
Cartridges’ in Chapter 1 for instructions.

= Make sure youve chosen the correct paper type in the Print dialog box.

» If youreusing plain paper, try flipping the stack of paper in the paper tray.
Most paper has one side that's better for printing. If youre using other
material, make sure you have it loaded in the correct orientation. See
“Loading Paper into the Paper Tray” in Chapter 1

= Try printing on a different kind of paper.
= Try choosing Best print quality in the Print dialog box.

» Try adjusting the Intensity control. Choose Page Setup or Print from the
File menu, and then click Options. In the dialog box that appears, choose a
different setting in the Intensity pop-up menu.

Thin lines fade or break up

Pick a darker color for the affected object, or try printing with the Pattern
halftoning option selected. (In the Print dialog box, click the Options button,
then choose Pattern from the Halftoning pop-up menu.)

The ink smears when rubbed

Dont handle pages before the printer drops them into the output tray. Wait
several minutes before handling doucments printed on glossy or PhotoGrade
paper or on transparency film.

Printing appears on only part of the paper
Check the selections in the Page Setup dialog box.

Clean the cartridges. See “Cleaning the Cartridges,” later in this Chapter. If
this doesrit help, replace one or both ink cartridges. See “Installing the Ink
Cartridges’ in Chapter 1 for instructions.



Colors don't ook right on the printed page

Try the following:

= Print a sample page to seeif youve run out of ink. For instructions, see
“Printing a Sample Page’ in Chapter 1

= Clean the cartridges See “Cleaning the Cartridges” later in this Chapter. If
this doesrit help, replace one or both ink cartridges. See “Installing the Ink
Cartridges’ in Chapter 1 for instructions.

= Try printing the image with ColorSync turned on. See “Quality” in
Chapter 3

= Use adifferent type of paper.

= Make sure youve selected the paper youre printing on from the Paper
Type pop-up menu in the Page Setup dialog box.

Unwanted horizontal white lines or stripes appear

Problems with print quality, especially horizontal white linesin your
document, may mean a nozzle on the print head is clogged or your ink
cartridge is running out of ink.

Clean the cartridges. See “ Cleaning the Cartridges” later in this Chapter. I
this doesrit help, replace one or both ink cartridges. See “Installing the Ink
Cartridges’ in Chapter 1 for instructions

IMPORTANT Cleaning the cartridges consumes a small amount of ink. If you
repeat the procedure unnecessarily, you reduce the life of your cartridges.

Troubleshooting
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Cleaning the cartridges

To clean the print head, load plain paper in the paper tray and make sure the
printer is turned on. Then follow these steps:

1  Cick Utilities in the Page Setup dialog box.

Orientation: Scaling (%):

Two-Sided Printing:

Color StyleWriter 4500 Page Setup -

Paper Size: Paper Type:

[ US Letter «] [ Plain Paper |
L Click Utilities.

[] Flip Horizontal
[JUse Color PhotoGrade Ink Cartridge
[ save as Default

2 Inthe Utilities dialog box, find Clean Print Cartridges and click Start.

Color Stylellriter 4500 Utilities

Clean Print Cartridge:
Align Print Cartridges:

o
o
El
[}
z

Click Start

The printer cleans the print head, printing a page in the process.

The image prints wavy or distorted

Make sure that you are using a recommended type of paper. If the problem
persists, see the information about service and support that comes with
the printer.

Stains appear on printed pages

Stains on the backs or tops of printed pages may mean that ink has spilled
insde the printer. If so, the ink can transfer to the rollers and from there to
the paper.

Turn the printer off and unplug it. Then open the printer and carefully clean
the rollers and platen with a soft, dry cloth.
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Ink cartridges run out of ink too quickly

To extend the life of your ink cartridges, try the following:

= Select Draft print quality in the Print dialog box whenever you can.
= Dorit clean the print head unless necessary.

= Dont print solid background colors unless necessary.

= Dot print the sample page unless necessary.
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Technical Information

General specifications

Marking engine

Four-color thermal ink-jet engine; six-color with the color PhotoGrade ink
cartridge

Resolution

The resolution differs according to the quality of printing you select. It is
expressed in horizontal by vertical dots per inch (dpi).

Best Black: 600 x 600 dpi

Best Color: 600 x 300 dpi on coated or glossy paper or on transparencies
(300 x 300 dpi on plain paper)

Normal Black: 600 x 300 dpi

Normal Color: 600 x 300 dpi on glossy paper or transparencies
(300 x 300 dpi on plain or coated paper)

Draft Black: 300 x 300 dpi
Draft Color: 150 x 300 dpi

Engine speed

Printing speed depends on the images printed and on the Mac OS-based
computer used.
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Connector cable

Apple System/Peripheral-8 cable

Interface

Local Talk
High-speed serial (RS-422-A)

Fonts

TrueType font support
64 TrueType fonts including the fonts provided on your computer

Adobe PostScript font support when used with Adobe Type Manager
software (sold separately by Adobe Systems I ncor porated)

Lower paper tray

Holds up to 100 sheets of 20-pound (75 grams/meter?) paper,
20 envelopes, 20 sheets of banner paper, up to 30 cards, up to 50
transparencies, up to 25 sheets of paper labels.

Output tray

Holds up to 50 sheets of 20-pound (75 grams/meter?) paper.

Printing materials

Plain paper: Use 16-pound (60-g/m?) to 36-pound (135-g/m3).

Envelopes: Use C6, DL, A2, or #10 envelopes, 20 to 24 |b. (75 to 90 g/m?).
Continuous banner paper: Use 20 Ib. (75 g/m?).

Labels: Accepts paper labels designed for ink-jet printers.

Cards. Use 110 Ib. index maximum, 8.5 pt. maximum (110 to 200 g/m?).

Apple recommends transparency film, premium coated paper, glossy
paper, and color PhotoGrade paper especially designed for the Color
StyleWriter 4500 printer. See your Apple-authorized dealer for more
details



Paper sizes in inches (") and millimeters (mm)

U.S Letter: 85" x 11" (2159 mm x 2794 mm)
Banner U.S Letter: 85" x 11" (2159 mm x 2794 mm)
US Legal: 85" x 14" (2159 mm x 3556 mm)
Executive: 7.25" x 105" (18415 mm x 266.7 mm)
A4: 83" x 117" (220 mm x 297 mm)

Banner A4: 83" x 11.7" (210 mm x 297 mm)

A5: 58" x 83" (1485 mm x 210 mm)

B5JIS: 72" x 101" (182 mm x 257 mm)

#10 envelopes: 95" x 4125" (241.3 mm x 104.8 mm)
C6 envelopes: 448" x 6.37" (114 mm x 162 mm)
DL envelopes: 4.33" x 866" (220 mm x 110 mm)
A2 envelopes: 4.375" x 575" (111 mm x 146 mm)
US Card 4x6: 4" x 6" (10061 mm x 1524 mm)

US Card 5x8: 5" x 8" (127 mm x 2032 mm)

A6 card: 41" x 583" (105 mm x 1485 mm)

Hagaki card: 39" x 58" (100 mm x 148 mm)

Printable area in inches (") and millimeters (mm)

Maximum printable line in portrait (normal) orientation: 8" (2032 mm)
Minimum margins

Left and right: 0.25" (604 mm)

Top: 0.26" (6.6 mm)

Bottom: 059" (150 mm)

Dimensions in inches (") and millimeters (mm)

Height: 79" (199 mm)
Width: 172" (436 mm)
Depth: 16" (405 mm)

Weight

Approximately 11.6 pounds (5.3 kilograms)

Technical Information
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Operating environment

Temperature

= 5°t040° C (41°to 104° F)

Relative humidity

= 10 percent to 80 percent, noncondensing

Altitude
= 10000 feet

Storage environment

Temperature

= —40° to 60° C (—40° to 140° F)

Humidity

= 5 percent to 90 percent, noncondensing

Altitude
= 10000 feet

Power Consumption

Operating

= 2 watts maximum when off

= 4.5 watts maximum nonprinting

» 12 watts maximum when printing

Power requirements for AC power adapter

The electrical requirements vary depending on the country for which your
model was manufactured.

Power supply

= AC power adapter



Apple printer supplies and accessories

If you have trouble finding any of the following products, the part numbers
may help you describe them to the dealer. Note, however, that part numbers
sometimes change as products are enhanced.

Ink cartridges

= Color ink cartridge: M5694G/A

= Black ink cartridge: M5693G/A

= Color PhotoGrade ink cartridge: M5692G/A

Connector cable
» Apple System/Peripheral-8 cable: M0197LL

Printing materials

Apple offers a complete line of high-quality, specialty ink-jet papers for
use in your printer. These papers are specially designed to make your
output look sharper, brighter, and more vibrant. Look for them at an
Apple-authorized dealer.

= Apple Color Ink-Jet Transparency Film

= Apple Color Ink-Jet Premium Coated Paper
= Apple Color Ink-Jet Glossy Paper

» Apple Color Ink-Jet Color PhotoGrade Paper
= Apple Color Ink-Jet Banner Paper

= Apple Color Ink-Jet Greeting Card Kit

Available Options
» LocalTalk RJ11 Connector Kit DIN-8: M1657Z/A
= LocalTalk Locking Connector Kit DIN-8: M2068LL/B

Where can you obtain these supplies and accessories?

See any Apple-authorized dealer. In the U.S, call 1-800-538-9696 for the
location of the dealer nearest to you.

Technical Information
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Kinds of fonts

Appendix B
Using Fonts With the Color StyleWriter 4500

A font is a collection of letters, numbers, and symbols in a distinctive
typographic design. Your Mac OS-based computer and Color StyleWriter
4500 printer come with a variety of fonts that look great both on your
monitor and on paper.

Fonts come in such a variety of formats that problems can sometimes arise
This appendix provides the information you need to avoid such problems and
to solve them if they come up.

The Mac OS-based computer works with three main kinds of fonts:
TrueType, bitmapped, and PostScript fonts.

Two kinds of fonts come with your computer and the Color StyleWriter 4500
printer: TrueType and bitmapped. However, your system can use PostScript
fonts as well when it has the proper software installed.
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TrueType fonts

A TrueType font is scalable, describing a typeface without rigidly specifying a
size So it looks good whatever size you choose TrueType fonts provide sharp
text at any size on screen or on paper. You can mix and match TrueType fonts
from various font vendors.

g

Courier

TrueType fonts store individual text characters as mathematical descriptions
of lines and curves, rather than as groups of pixels (a bitmap). When a
program asks for a character in a particular size, such as 33 points, the
computer uses mathematical calculations to enlarge the character's outline
to 33 points and fill in the dots for the monitor or printer output.

Sometimes you Il still get jagged edges when you print a document, even
when you use a TrueType font. In nearly all cases, thisis because there isnt
enough memory available to scale the font properly for printing. This may
happen, for example, when youre running several programs at the same time

Because you dorit need a separate font for each character size in order for
your printing to look good (as you do with bitmapped fonts), TrueType font
names dort have numbersin them.



How does a font look? To see what a TrueType or bitmapped font looks like
on your screen, double-click the font'sicon to open it. A sample of that font
appears (in three sizes for TrueType fonts and in the size you opened for
bitmapped fonts).

=_|

Palatino === El

Palatino 12

-3 point - Sample
How razotbackjumping frogs can level six piqued How razorback-jumping frogs can
) lewel six piqued gyrmnasts!

=12 point
Howr razorback-jurnping frogs can level
six piqued gymrrasts!

18 point

Howr razorback-jumping
frogs can level six piqued
gymnasts!

To uze thiz font, drag it onto your System Folder

To use this font, drag it onto your Systemn Folder

You can also use the Key Caps desk accessory to examine fonts. See the
documentation that came with your computer for instructions.

Bitmapped fonts

Bitmapped fonts consist of “pictures’ of atypeface at specific sizes For
example, you might have bitmapped fonts at 10-, 12-, and 18-point sizes
installed in your computer. For best results you need a separate font file for
each size of character you want to use

Theicon of a bitmapped font (also called a fixed-size font or screen font) has
the single letter A on it. The font's point size appears at the end of its name

A

Monaco 12

When you request a bitmapped character, your computer |ooks for an
installed bitmapped font in the size you specified. (See “How the Computer
Looks for Fonts’ later in this appendix) If it carit find that font, your
computer tries to construct one by scaling a size that it does find.
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In most cases, scaled bitmapped fonts dorit look nearly as good as
preinstalled ones. Such scaling is one reason for the jagged edges (sometimes
called “jaggies’) you Il see on your screen or in a printed document when you
request an uninstalled size (for example, 17-point Geneva).

Bitmapped fonts are designed on grids of 72 dots per inch (dpi)—the
standard Mac OS—based computer screen resolution. Because of their
correspondence to the standard screen resolution, bitmapped fontsin
preinstalled sizes aways look great on your display.

When you print a bitmapped font, it prints at a resolution of 72 dpi. Because
most modern printers can print at resolutions far better than this (your
Color StyleWriter 4500 prints at 300 dpi or better), printed bitmapped fonts
almost always have jagged edges or stairstep sides.

Fortunately, the computer can use bitmapped fonts in combination with other
font formats, reserving bitmaps for the screen and other kinds of fonts for
the printer.

PostScript fonts

PostScript is a page-description language that defines the characters, symbols,
and images that appear on each page of a document. A PostScript font comes
asapair of fonts: an outline font for the printer and a corresponding
bitmapped font for displaying type on your screen.

No bitmapped font, no menu entry: If your system doesrit have the bitmapped
font, the PostScript font name wor't appear in your font menu.

Couri

Certain printers are designed specifically to work with PostScript fonts
While your Color StyleWriter 4500 is not a PostScript printer, it can use
PostScript fonts if you have Adobe Type Manager software installed. Adobe
Type Manager uses printer fonts to generate clean-looking screen text at any
size (This software is included with some installations of system software 7.5
It is available from your local Apple-authorized dealer for version 71)



IMPORTANT Adobe Type Manager is not an Apple product. It is made and
supported by Adobe Systems | ncorporated. Only the version that comes with
Apple Macintosh system software version 75 is supported by Apple

PostScript printer fonts have no numbers associated with their names,
because a single font can be scaled to any size Many companies make
PostScript fonts; the following illustration shows icons for Adobe, Bitstream,
and Fontek PostScript fonts, plus a generic PostScript font icon.

Zl & [El &
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Although TrueType fonts offer distinct advantages, your Color StyleWriter
4500 printer can also use other kinds of fonts.

TrueType and bitmapped fonts

Mac OS—-based computers running System 7 come with both bitmapped
(screen) fonts and TrueType fonts installed. This maintains consistency with
documents created on Mac OS—based systems that don't have TrueType fonts.

EDE Courier EEE
123 items 142.2 ME in disk 9.7 ME available

Courier

{3

Courier 3 Coyrjer 10 Courier 12 Courder 14 Courier 18

i
<] E2E

Bitmapped fonts look better displayed on the monitor, while TrueType fonts
look better on a high-resolution printer such as the Color StyleWriter 4500.
So, if you have both versions of the font available, your computer uses the
bitmapped version when displaying the font on the screen (provided that the
Szeyoure using is available) and the TrueType version when printing the font
on the Color StyleWriter 4500. To force the Macintosh to use only TrueType
fonts everywhere, you must remove the bitmapped fonts.

For example, if adocument uses 12-point Times®, available in that sizeasa
bitmapped font and as a TrueType font, the system uses the bitmapped font on
the screen and the TrueType font on the printer. If a document uses 4-point
Times, the system scales the TrueType font to that size for both the screen and
the printer, because a bitmapped version isrit available



Using only TrueType fonts produces a closer match between the appearance
of type on the screen and on paper. However, a document youve already
created with bitmapped fonts will be reformatted with the corresponding
TrueType fonts, and line breaks in the document may change Smilarly, if a
document is created on a system that has TrueType fonts or Adobe Type
Manager software installed, it may have different spacing, kerning, and so on,
when opened on a system that doesrit have TrueType fonts or Adobe Type
Manager software

Keeping two font versions available

If you have a TrueType version of afont, you dor't need a bitmapped version.
However, although keeping both versions of afont takes up more disk space,
there are several advantages to doing so.

Bitmapped fonts are hand-designed: a graphic artist planned each character
in each font to look good on a screen. TrueType fonts are scaled by the
computer to match what you request. At smaller point sizes, the bitmaps may
appear sharper on the screen.

Additionally, scaling fonts takes time—sometimes up to several secondsin
dower computers—but all MacOS-based computers can display a bitmapped
font instantly.

TrueType and PostScript fonts

PostScript fonts were designed as fonts for PostScript printers. The Color
StyleWriter 4500 wasrit designed to use PostScript. However, if you have
Adobe Type Manager software installed, your computer can both display and
print PostScript fonts.

Use different names: To avoid confusing the printer software, be sure that you
dorit install both TrueType and PostScript versions of the same font. For
example, do not have a PostScript font file called Times and a TrueType font
file called Timesinstalled in your system at the same time
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Herés the search order your computer uses to determine which font to display
on your screen when you choose a specific size:

1 aninstalled bitmapped font in that size, if one exists
2. ascaled TrueType font, if no bitmapped font exists

3 an Adobe Type Manager (ATM) version of a PostScript font, if ATM is
installed and if no TrueType version exists

4. ascaled bitmap if no ATM font exists

Herés the search order it uses to determine which font to print on your
Color StyleWriter 4500 printer:

1 ascaled TrueType font, if one exists

2. an ATM version of a PostScript font, if ATM isinstalled and if no
TrueType verson exists

3 ascaled 72-dpi bitmap if no ATM font exists



Where fonts are stored

All fonts for your Color StyleWriter 4500 printer reside in special places
within the System Folder. To install fonts, you drag them to the System
Folder. Your computer will automatically put them where they belong—in the

Fonts folder within the System Folder.

The Fonts folder can contain atotal of 128 font suitcases (described in the

next section), plus any number of PostScript fonts, up to the available storage

capacity of your hard disk.
EO=—— funts 25
Name Size  Kind Y
— il
HelveMarbl FEK PostSeript™ font
Helvetica 4K font suitcase
HyperChatacters brap 12K font suitcase
London 4K font suitcase
Los Angeles 12K font suitcase
MerrionSquare brap 8K font suitease
é MerriSqu 24K PostSoeript™ font
Mobile 12K font suitcase
Monaco SEK  font suitcase
MT Extra 20K font suitcase
ﬁ MTE=t 12K PostSeript™ font
Mew Yaork 28K font suitcase
Falatino 298K font suitcase
San Francisco 4K font suitcase
Symbal TZK  font suitcase
Tirmes 264K font suitcase
N

IMPORTANT Fontsinstalled in other folders or in the top level of the System

Folder may not work correctly. Additionally, bitmapped and TrueType fonts

stored outside of suitcases may not work correctly.

Using Fonts With the Color StyleWriter 4500
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Suitcases

A font suitcase is a special folder for collections of fonts.

4]

Courier

Suitcases provide a convenient way to organize fonts in the same font family.
For example, its agood idea to use a single suitcase (called Courier) for all
fonts in the Courier font family—all Courier roman fonts as well as fonts
with names like Courier Bold and Courier Oblique

E1=——-= Courier =——"=R2
23 items 142.1 ME in disk £9.5 ME available
| Marme. Size  Kind

|d El Courier BoldOblique 12 12K font
E El Courier BoldOblique 24 15K font
@ Courier SOK font
E Courier 9 SK font
B courier (botd) Sek font
[ courier 10 5K font
(Al courier1z &K font
[ courier 14 6K font
(A courier 12 T font
(A courier 24 10K font
E | Courier Oblique 10 T font
E | Courier Oblique 12 T font
= [

Combining suitcases: To merge all the fonts from one suitcase with another,
drag one suitcase on top of the other. All the fonts from the dragged suitcase
will go into the other, and the dragged suitcase will disappear.

Note: To avoid confusion, rename a font suitcase whenever you put more
fontsinto it. For example, if you decide to merge Helvetica, Helvetica Black,
and Helvetica Compressed, name the suitcase something like “Helvetica
Regular/Black/Condensed.”

A auitcase can also contain fonts from different font families, although you
should keep all fonts of the same family in the same suitcase All the fonts
will still appear in menus with their proper names.



Styled fonts

You treat a suitcase as you would a folder. To open a suitcase, you double-
dick it. To add afont, you drag the font's icon to the suitcase and drop it in.
To remove afont, you drag itsicon out of the suitcase

To create a font suitcase, duplicate an existing one and throw away its
contents. Then rename the suitcase as appropriate and drag whatever fonts
you want into it.

You cannot have more than 128 font suitcases in the Fonts folder.

Sze limits for suitcases: No matter how many fonts you have in asingle
suitcase, the Fonts folder counts the suitcase as a single unit. Therés no limit
to the number of fontsin a single suitcase, but the suitcase cannot be larger
than 16 megabytes.

Most fonts that come with your Color StyleWriter 4500 printer have defined
styles. For example, if you open the Bookman font (contained in a suitcasein
the Fonts folder, which isinside your System Folder), you see files for bold
and italic versions of the font.

E1=——— Bookman =————15
14 items 55.4 ME in dizk 16.6 ME available
i

EBookman Evokman (bold)

Eookman (italic) Bookrnan (hald, italic)

|

<] [
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But fonts such as Chicago, Geneva, Monaco, and New York do not come with
defined styles. If you open the Chicago font suitcase, you see only one file

EN Chicago =HI
(511 itern 584 MBindisk 166
i

Chizago

=]
<] [o[E

You can apply a style to afont like this by making a choice from the
appropriate menu (Fonts, Style, Format, or some similar menu, depending on
the application program). A font predesigned with a given style nearly always
looks better than a font with a computer-generated “derived’ style

About style names: Predesigned styled fonts sometimes have names you may
not be familiar with. For example, roman refers to a font without styling, or
plain. Oblique is smilar to italic. Light, demi, and extra are different kinds

of bold.

Common questions about fonts

Appendix B

Here are some questions that often come up about fonts
What kind of fonts should | buy?

Using a font that has both bitmapped and TrueType versions works best. The
bitmapped version looks great on the screen and the TrueType fonts print
beautifully on the Color StyleWriter 4500.

Avoid bitmapped fonts that dorit have TrueType versions because they print
with jagged edges on the Color StyleWriter 4500. By contrast, TrueType fonts
work well, even if you dor't have a bitmapped version.

If you have a PostScript printer or Adobe Type Manager, PostScript fonts
look great on paper. The Color StyleWriter 4500 is not a PostScript printer.



Why don't all of my fonts appear in the Fonts menu?

You may not have all of your fonts placed correctly. All the fonts should be
installed in the Fonts folder in the System Folder.

Additionally, some application programs let the user decide which fonts
should appear in the Fonts menu. Check the manuals that came with your
programs

Why can’t | see my Monaco 9, Geneva 9 and 12, and Chicago 12 bitmapped fonts?

These fonts are used by your Mac OS-based computer to display information.

Because the computer needs these fonts, the Finder makes them invisible to
prevent users from removing them.

What does the term Apple classic fonts mean?

The Apple dassic fonts are the original ten bitmapped fonts that came with
the first Macintosh in 1984. These fonts, which all have city names, include
Athens, Cairo (a picture font), Chicago, Geneva, London, Los Angeles,
Monaco, New York, San Francisco, and Venice Several of the fonts (Athens,
Cairo, London, and San Francisco) came in only one size—18 points

This is a sample of Athens.
Qﬁw\r ﬁm g mﬁ?@m"@ {Cairo}

This is @ sample of Chicago.
Thig is a sample of Geneva.

This is a sample of Tondon.
Thiz Iz @ sample of Loz Angeles.

This is o sample of Monaco.

This is a sample of New Tork.

Thil i§ a bample of Ban Franeiico.

This is a sample of Venice.
Chicago, Geneva, Monaco, and New York are currently available in TrueType
versions. The other classc fonts are still only available in bitmapped versions.

Why do | sometimes get Geneva or Courier in my printed documents when | have
specified other fonts?

Geneva sometimes appears when youre trying to use a TrueType font but
dorit have enough memory for scaling to operate properly.

Substitute fonts can also appear in a document composed on one Macintosh
that has a particular set of fonts but printed on another Macintosh that doesr't
have those fonts.

Using Fonts With the Color StyleWriter 4500
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Why does a document written entirely in Times look different on different Macintosh
computers?

Times, an extremely popular font, is manufactured and sold by more than one
company. Such fonts usually have small differences, even though they have the
same name. For example, the Times font manufactured by Adobe Systems
Incorporated has different letterspacing than does the Times font from Apple
Computer, Inc.

What is font substitution?

Font Substitution, which isrit available for your Color StyleWriter 4500
printer, is an option in the Page Setup dialog box for certain PostScript
printers When font substitution is turned on, these printers will use their
built-in equivalents for three bitmapped fonts (Times for New York, Helvetica
for Geneva, and Courier for Monaco).

What's a downloadable font?

A downloadable font is a TrueType or PostScript font sent to some kinds of
printers, such as most PostScript Laser printers, by your system software The
printer then uses the font to print your document.

If aprinter has sufficient memory, it can hold more than one downloaded
font; otherwise it must request the fonts it needs as necessary. This can be a
time-consuming process.

Some printers have hard disks attached to them for holding downloaded fonts
A printer can get the fonts from its hard disk more quickly than it can
download them from the computer's hard disk.

Your Color StyleWriter 4500 printer cannot receive downloaded fonts.
Instead, your computer composes the entire image and then sends it to your
Color StyleWriter 4500 for printing.



Appendix C
Font List

Between the fonts that come with your Mac OS—based computer and those
that come with the printer, there are 28 font families (and 64 total styled
fonts) available as soon as you install the Color StyleWriter 4500 software.

Name in Font menu

Avant Garde

Bookman

Chicago

Courier

DELPHIAN

Garamond Narrow

Geneva

Helvetica

Helvetica Black

Helvetica Compressed

Number of fonts

4

Font family (and styled fonts)

ITC Avant Garde®
(plain, italic, bold, and bold-italic)

ITC Bookman®
(plain, italic, bold, and bold-italic)

Chicago

Courier
(plain, italic, bold, and bold-italic)

Delphian

ITC Garamond® Narrow

(plain, italic, bold, and bold-italic)
Geneva

Helvetica®
(plain, italic, bold, and bold-italic)

Helvetica Black
(plain and italic)

Helvetica Compressed
(plain and italic)

Comes with

Color
StyleWriter 4500

Color
StyleWriter 4500

Macintosh

Macintosh

Color
StyleWriter 4500

Color
StyleWriter 4500

Macintosh

Macintosh

Color
StyleWriter 4500

Color
StyleWriter 4500

continued »
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Appendix C

Name in Font menu

Lubalin Graph
Lucida Bright
MACHINE

Monaco

N Helvetica Narrow
Nadianne
New Century
Schoolbook

New York
Oy €nglish Text

Onyx

Oxpord

Palatino

Swing

ZyuBol (Symbol)
Times

Zapf Chancery
K&k kRO EVA
(Zapf Dingbats)

Z3% 4 % (Zeal)

Total

Number of fonts

4

64

Font family (and styled fonts)

ITC Lubalin Graph®
(plain, italic, bold, and bold-italic)

Lucida Bright
(plain, italic, bold, and bold-italic)

ITC Machine®

Monaco

Helvetica Narrow
(plain, italic, bold, and bold-italic)

Nadianne
(plain and bold)

New Century Schoolbook
(plain, italic, bold, and bold-italic)

New York
Old English Text

Onyx

Oxford

Palatino®

(plain, italic, bold, and bold-italic)
Swing

Symbol

Times®
(plain, italic, bold, and bold-italic)

ITC Zapf Chancery®
StyleWriter 4500

ITC Zapf Dingbats®

Zeal

Comes with

Color
StyleWriter 4500

Color
StyleWriter 4500

Color
StyleWriter 4500

Macintosh

Color
StyleWriter 4500

Color
StyleWriter 4500

Color
StyleWriter 4500

Macintosh

Color
StyleWriter 4500

Color
StyleWriter 4500

Color
StyleWriter 4500

Macintosh

Color
StyleWriter 4500

Macintosh
Macintosh
Color
Color

StyleWriter 4500

Color
StyleWriter 4500



Appendix D
Using ColorSync

Mac OS-based computers use ColorSync to help make sure that the colors
you see on your monitor closely match the colors you get on your printers,
scanners, and other devices. Because ColorSync works behind the scenes, you
dorit have to know anything about it. All you need to do isinitially set it up.
This appendix describes how ColorSync works and how to configure your
monitor and computer to take advantage of it.

The problem that ColorSync solves

Providing consistent color with desktop computersis atechnical challenge
because different color devices use different methods for representing color,
and they produce different ranges of colors. For example, the colored light on
your monitor is very different from the colored inks your printer uses

Different color devices also create color using different methods Monitors
(and most scanners) produce colors by mixing red, green, and blue light—
called RGB color. Most printers produce colors by mixing cyan (a shade of
blue), magenta (a bright pink), yellow, and black ink. This color system is
called CMYK. Since monitors, printers, and scanners each have different color
capabilities, they cannot reproduce each other’s colors exactly.
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Further compounding the problem is that no two monitors or printers
produce exactly the same colors (For example you can see differencesin
color ability among monitorsin the TV department of a consumer
electronics store)

ColorSync is a system extension that provides color-conversion capabilities
and improves color consistency. ColorSync “trandates’ the colors used on one
device s0 that they more closely match the colors displayed or printed on
another device

ColorSync color conversion is a central part of Mac OS-based computing,
ensuring that applications, monitors, printers, scanners, and digital cameras
can use the same scheme for color conversion. This means you can scan an
image, display it on your monitor, and print it—with visually matching colors
every step of the way.

How ColorSync works

Appendix D

When you create a TIFF or PICT file usng a program that supports
ColorSync, a“profil€’ describing the color capabilities of your equipment is
saved with the image For example, when you scan a photograph, a profile
describing the scanner is saved insde the image file If you later print the
image, even using a different computer, ColorSync looks at the profile to learn
about the capabilities of the scanner you used, and automatically picks closely
matching colors that your printer can reproduce

The profile contains information ColorSync needs to perform color matching,
such as the lightest and darkest possible tones (white point and black point)
that the device can produce, and the maximum supported densities for red,
green, blue, cyan, magenta, and yellow. Together, these characteristics
describe the color gamut (or range) that a device is capable of capturing,
displaying, or reproducing. To take advantage of ColorSync, each of the
imaging devices you use needs to have its own ColorSync profile When you
create images using these devices, information from the profile will
automatically become part of the image file—ensuring that colors are
consistent throughout the entire creative process.



Because ColorSync information becomes part of your output files, you dont
have to worry about losing the profile or using the wrong profile with the
wrong image Additionally, ColorSync profiles are in the standard
International Color Consortium (ICC) format recognized by Microsoft
Windows, Mac OS and other systems.

When you work with an image that has an embedded ColorSync or ICC
profile, ColorSync identifies the colors that your monitor or printer can
reproduce by examining their ColorSync profile It compares their capabilities
with those of the system used to create the image (as described in the
embedded profile), and then picks appropriate, matching colors. For example,
your monitor may be able to display avivid red, but your printer inks may not
be able to produce that color. ColorSync determines the “next best” color for
your printer to use

Monitor Printers
= [T
| |
L. .. ‘ ColorSync profile R4
..‘
\ 3 4
ColorSync

-'.( '-.
Digital cameras Scanners

ColorSync performs color matching by comparing each profile to an
independent color standard. ColorSync uses the CIE color standard, which
describes colors in terms of how they are perceived by the human eye under
specific lighting conditions (CIE stands for the Commission International de
I' Eclairage, the International Commission on Illumination, which created the
standard in 1931)

Using ColorSync
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Setting up ColorSync

Appendix D

To take advantage of ColorSync, you need to obtain profiles for each of your
imaging devices, such as your monitor, scanner, and color printer. ColorSync
profiles are usually automatically installed when you install the software for a
ColorSync-supported device Profiles are stored in the ColorSync Profiles
folder, insgde the Preferences folder in the System Folder. If you need to
obtain a ColorSync profile, contact the manufacturer of your device. Ask for
either a ColorSync or ICC profile for the specific model of monitor, printer,
or scanner youre us ng.

You also need to make sure the ColorSync extension and Apple CMM 2 are
installed and active. ColorSync is automatically installed in the Extensions
folder of your System Folder during software installation. Unless youve
removed or disabled it, it's already installed.

Finally, you need to set a ColorSync System Profile for the Mac OS The
ColorSync System Profile is used by ColorSync to determine the color range
of your monitor. ColorSync compares this information with the profiles of
your other devices to make sure that colors are consistent with what you see
on your monitor.

Additionally, the System Profile is used as a default profile if a document you
are working on doesrit have any ColorSync information saved within it. This
can occur if the document was created without ColorSync installed. By using
the System Profile as a default, ColorSync ensures that colors are consistent
with what you currently see on your monitor.

For the best color on your Color StyleWriter 4500 printer, you need to choose
a specific profile for your monitor. In the ColorSync control panel, choose the
D50 profile for your monitor. If there is no D50 available for your monitor,
choose Apple Multiple Scan 17 — D50. The D50 profile gives you better
“warm’ colors.



For the best visual match between the colors on your monitor and printed
colors, select the Page-White Gamma option in the Monitors control panel.
(On some computers, this may be called the Monitors & Sound control
panel.) To select a gamma option, open the Monitors control panel, then hold
down the Option key while you dick the Options button. In the Options
window, click the Use Special Gamma checkbox to put a check init. Then
choose Page-White Gamma from the menu.

On amultiscan monitor, make sure that the color temperature, or intensty, is
set to 9300 K (the default setting). See the monitor manual for instructions. I
you select the Page-White Gamma option with a color temperature other than
9300 K, your monitor colors could look too red or too blue compared to
printed colors

Setting the ColorSync System Profile

To set the System Profile, follow these steps:

Make sure the profile you want to use is located in the ColorSync Profiles folder.
This folder islocated in the Preferences folder in your System Folder.

Choose Control Panels from the Apple (8) menu and open the ColorSync System Profile
control panel.

The ColorSync System Profile control panel appears.

EO=—— ColorSync™

241
Set Profile...

#ppletision 850 - 9300

Click Set Profile.

A dialog box appears with alist of ColorSync prafilesinstalled on your
computer.

Using ColorSync
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Appendix D

4

Click the profile you want to use.

Select New System Profile:

|ﬁ ColorSync™ Profiles V| —Mac HD 80
Apple Multiple Scan 15
Apple Multiple Scan 17 - 9300
Aipple Multiple Scan 17 - D50 Desktop
Apple MUItiple SCan 17 - D65 [T -
Apple Multiple Scan 1705
Apple Multiple Scan 20 - 9300
Apple Multiple Scan 20 - D50 I Select I

Apple Multiple Scan 17 - D50

Select the D50 profile for your monitor, or Apple Multiple Scan 17 D50 if you
carit find a D50 profile for your monitor.

Click Select.

ColorSync automatically references the profile you selected and uses it to
define the color capabilities of your monitor.

Close the ColorSync System Profile control panel.

Setting other ColorSync profiles

Some programs and printer software might require that you do something
special, such as turning on an option, in order to take advantage of ColorSync.
For example, to use ColorSync with the Apple Color OneScanner, select the
Use ColorSync option in the ColorSync Preferences dialog box of the
OneScanner Dispatcher software This tells the scanning software to embed
information about the Color OneScanner in scanned images.

Refer to the instructions that came with your application or device to
determineif it supports similar options. If therés an option to specify a
profile or to activate ColorSync, be sure to use it.



Tips for best results

After youve made sure ColorSync isinstalled, set the System Profile, and set
any necessary ColorSync options for your applications, youre ready to begin
taking advantage of ColorSync! Just scan, create, and print your images or
documents as you normally would. ColorSync works behind the scenes to
ensure congstent color matching.

The following settings and strategies will help you get the best color results
from your system. Not all of these tips will apply to the software and devices
you may be using, but be sure to take advantage of those tips that do.

Set the gamma curve for your monitor to 18;:Standard to have the monitor
more closely match printed results..

Use the ColorSync System Profile control panel in the Apple (&) menu to
select the D50 profile for your monitor, or Apple Multiple Scan 17-D50 if
you carit find a D50 profile for your monitor. If you calibrate your monitor,
you can create a custom profile and select it as the system profile instead.
See the documentation that came with your monitor for more information
on creating custom ColorSync profiles.

When printing in color, be sure to select the ColorSync option. In the Page
Setup dialog box, click the Options button and select “ColorSync’ from the
Color Matching pop-up menu.

If your scanning program has a ColorSync option, use it. This embeds a
ColorSync profile within the scanned image file, and ColorSync will be
better able to reproduce the original colors on your monitor and printer.

Dont try to use two color-matching systems at once on your computer.
Some applications install other color-matching systems. These should
either be removed or disabled if you want to use ColorSync.

Using ColorSync ' 113



For more information
To learn more about ColorSync, or color matching and color technology in
general, refer to these publications and resources.
Publications

Advanced Color Imaging on the Mac OS Apple Compulter, Inc.,
Addison-Wed ey Developers Press, |SBN 0-201-48949-X

ColorSync 20 White Paper at gopher://info.applecom

Internet Resources

Apple Imaging Web Ste at http://imaging.applecom

Apple Technical Information Library at http://til .info.applecom
International Color Consortium at http://www.color.org

ColorSync plug ins for use with Adobe Photoshop (Macintosh Utilities
section of the Apple Software Updates page on the Apple Support and
Information Web at http://www.info.apple.com)
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Index

A

AC power adapter, power
requirements 88
Acrobat Reader Help 26
address, return 42
Adobe Acrobat Reader Online Guide 26
Adobe PostScript font support 86
aligning ink cartridges 21-22
Apple-authorized service providers 67
dealer phone number 89
Appleclassic fonts 103
Apple Color Ink-Jet printing materias
Banner Paper 38, 61
Color PhotoGrade Paper 34, 60, 62
Glossy Paper 60
Premium Coated Paper 60
recommended 86
Transparency Film 61
Apple Printer Software Collection
CD-ROM 12
Apple printer supplies and accessories
89
Apple QuickDraw GX software,
incompatibility 12
applications, virus-detection 13, 15
Auto color setting 33

Y

Can't Find It? See also Macintosh Guide's

onscreen index. Open the Guide (@) menu and

choose Macintosh Guide (or Mac OS Guide);
then click the Index button.

B

background printing
controlling and monitoring 32
delays 34
turning on and off 31
backwards printing 79
banner paper
printing with 38-41, 61
special instructions 62
birthday greetings, printing 61
bitmapped fonts 93-94
icon 93
using with TrueType fonts 96-97
black ink cartridge
installing 9-11
removing 35
testing 22
blinking lights, indicating problems
72-73
bold fonts 101-102
business-size envelopes, printing 42-46
buttons, on printer 8
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=

Can't Find It?

See also Macintosh

Guide’s onscreen index.

Open the Guide (@)
menu and choose
Macintosh Guide
(or Mac OS Guide);
then click the

Index button.

Index

C

cables
connecting printer to computer 6
part numbers 89
shielded vi
canceling printing 32
cards
loading 61
printing 51-53
carrier, for ink cartridges 9-11
carton, unpacking 3-4
cartridges. Seeink cartridges
CD-ROM, installing printer software
from 12-15
Chooser (Apple menu)
Color SW 4000 Seriesiconin 68
selecting printer in 16
choosing printing materials 59-62
CIE color standard 109
cleaning the printer 2, 66
CMYK color system 107
coated paper 60
specia instructions 62
color images, printing in grayscale 30
color ink cartridge, installing 10-11,
21-22
Color Options dialog box 63
color PhotoGrade Ink cartridge. See
PhotoGrade Ink cartridge
Color PhotoGrade paper, special
instructions 62
colors
adjusting 33
best 63
CMYK system 107-108
consistency 107-114
faded 80
missing or faded 65
RGB 107
untrue 81
Color StyleWriter 4000 Series Minimal
Printer Software floppy disk,
installing from 12

Color StyleWriter 4500 printer. See also
printer
main features ix
unpacking 3-4
ColorSync
color-matching system 33, 107-108
explanation 108-109
profiles of imaging devices 110-112
publications and Internet
resources 114
tipsfor using 113
commands
CSW Guide (Guide [7] menu) 24-25
Page Setup (File menu) 21, 37
Print (File menu) 28, 30
PrintMonitor (Application menu)
32,54
computer
crashing 70
failing to recognize printer 70-71
font search order 98
monitoring background printing 32
selecting Color StyleWriter 16-17
computer paper, continuous 38-40, 62
connecting printer to computer 6
connector cable 86
part numbers 89
continuous computer paper
for printing banners 38-40
specid instructions 62
copier paper, weight 59
copies, print settingsfor 30
copying software 15
corrupted fonts, removing 69
costs, printing materials 64
cover
closing 11
opening 9
safety instructions 1
crashing computer 70
CSW 4000 Seriesicon, in Chooser 16
CSW 4000 Series Printer Guide
help for color options 33
opening 24
tipsfor using 25



CSW Guide command (Guide [7]
menu) 24
Custom Ingtall 15

D

damage
power cord 2
preventing 9, 68
defining terms 25
demi font 102
disconnecting power 5
disk duplication 12
documents
horizontally flipped 56
non-standard 29-30
page settings 29
planning 27
print settings 30
problems printing pages 75
standard 28
unexpected results 77-82
waiting to print 32
double-sided printing 54-55
downloading fonts 104
draft printing 30
duplex printing (two-sided) 54-55

E

electrical hazards 2
electricity, frequencies 5
electromagnetic interference 4
electronic user’s setup manual 26
engine speed 85
envelopes
feeding improperly 74
loading 19-20
non-standard 58
positioning 43
printing single 42-43
printing stack 44-46
size settings 29

error messages
background printing 31
installation 13
wrong port 76
expenses, reducing 64
external paper selector, adjusting 29
External serial port setting 18
extrafont 102

F

faded colorsand lines 80
film, transparency 47-48, 61
flashing lights 9
Flip Horizontal, page setup for 56
floppy disks
creating from disk images 12
for installing printer software 12
font families, in suitcases 100-101
font list 105-106
Font menu names 105-106
fonts
Appleclassic 103
bitmapped 93-94
corrupted 15, 68-69
downloading 104
familiesin suitcases 100-101
installing 12
list 105-106
missing 103
mixing 96-97
names 97
order in System Folder 99
PostScript 94-95
problems 77
purchasing 102
search order on computers 98
styled 101-102
substitution 103-104
supported 86
Timesvariations 104
TrueType 92-93
frequencies, electric 5
front cover
closing 11
opening 9

Index
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Can't Find It?

See also Macintosh

Guide’s onscreen index.

Open the Guide (@)
menu and choose
Macintosh Guide
(or Mac OS Guide);
then click the

Index button.

118  Index

G

glossy paper 60
specia instructions 62

graphic images, jagged 78
Guide window, moving 25

H

hard disk, space requirements x
hardware
correct 15
requirements x
help
Adobe Acrobat Reader Online
Guide 26
CSW 4000 Series Printer Guide
(Finder) 24-25
electronic user’s setup manual 36
Macintosh Guide (Finder) 24
horizontal lines, print quality
problems 81
“Huh” button 25

l,J, K

icons
bitmapped fonts 93
CSW 4000 Seriesin Chooser 16, 68
modem and printer port 6
PostScript 94-95
TrueType 92
images
colored 30
fuzzy 80
jagged 78
wavy or distorted 82
image size, page setup for 29
index cards
loading 61-62
printing 51-53

information
in CSW 4000 Series Printer Guide 25
technical 85-89
ink
preventing stains 11
smearing 80
ink cartridges
aligning 21-22
cleaning 82
conservingink 64
drying out 8
extending life 83
inserting PhotoGrade cartridge 36
installing 9-11
page setup for PhotoGrade cartridge
29, 37
part numbers 89
preventing damage 9
removing black ink cartridge 35
replacing 65
safety instructions 1, 68
diding carrier 9
storing 4, 11, 35
tape on print head 10
unpacking 3
Ink-Jet printing materials 60-61
installation
ink cartridges 9-11
printer software 12-15
troubleshooting 15, 68-69
Installer program, installing printer
software 12-15
instructions, onscreen 25
interface
port 6
specifications 86
interference
radio and television vi
from transmissions 4
internal modem, special setup for 18
Internet resources, for ColorSync 114
italic fonts 101-102



L

labels
loading 61
printing 49-50
specia instructions 62
landscape page orientation 29
length adjuster 19, 46
light font 102
lights
indicating problems 72-73
resume 9
lines
fading 80
unwanted horizontal 81
loading printing materials
banner paper 39
coated paper 60
for color printing 60
continuous paper 61
custom size 57-58
envelopes 42-46
feeding improperly 74
glossy paper 60
index cards 51-53
labels 49-50
PhotoGrade paper 34
photo-quality paper 60
plain paper 59
postcards 51-53
in sheet feeder 19-20
specia instructions 62
transparencies 48
for two-sided printing 55
Local Tak network
connector kits 7, 89
selecting in Chooser 17
lower tray. See also paper trays
capacities 86

loading custom-size paper 57

loading printing materials 62
stacking cards 52

M

Macintosh computers, serial port 6
Macintosh Operating System (Mac OS)
available fonts 105-106
version 7.1 requirements x
Macintosh PowerBook owners
printing problems 8, 71
special setup information 18
Mac OS-based computers
available fonts 105-106
help 24
system requirements for printer x
maintaining the printer 65-56
manual duplex printing (two-sided)
54-55
page setup for 29
marking engine 85
matching colors 63
media. See paper types
memory
not enough 13
problems 76-77
RAM requirements X
virtual 8
messages
background printing 31
installation 13
wrong port 76
modems
port 6
selecting in Chooser 16
setup for internal 18
monitors, matching colors 33, 63,
107-109
moving the ink cartridge carrier 9
multiscan monitor, matching colors
33,63, 111

Index
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Can't Find It?

See also Macintosh

Guide’s onscreen index.

Open the Guide (@)
menu and choose
Macintosh Guide
(or Mac OS Guide);
then click the

Index button.

Index

N

network
changing printer name 17
connecting printer to Local Talk 7
printing problems 71

Normal serial port setting 18

0

oblique font 102

onscreen help 24-25

operating environment 88
options, color 33

orientation, page setup for 28-29
output tray, capacity 86

P

packing materials 3-4
page breaks, unexpected 78
page orientation, page setup for 28-29
pages
failing to print 75
off-center printing 78
printable area 87
printing both sides 29
range of printing 30
sample 23
stained 82
page setup
banners 38
business-size envelopes 42
custom-size paper 58
dialog box 29
flipped documents 56
index cards 51
labels 49
photographs 37
postcards 51
stacked envelopes 44
transparencies 47
two-sided printing 54

Page Setup command (File menu) 21, 37

Page-White Gamma option (Monitors
control pandl), for matching
colors 63, 111
paper
advancing 41
choosing 59-62
cost 64
defining custom size 57-58
jam 73
partialy printed 80
quality 63
sizes 29, 87
speed of printing 64
paper adjusters 19-29
for custom-size paper 58
for printing envelope stack 44-46
for stacking cards 52-53
paper-backed transparencies 48, 62
paper selection lever 19, 23
paper selector, adjusting 29
paper trays
for custom size paper 57
for envelopes 43-46
for labels 5C
for photographic paper 34
stacking cardsin 51-53
for standard paper 19-20
for transparencies 48
for two-sided printing 54-55
paper types
banner 38
choosing and using 59-62
custom size 57-58
improper choices 79
index cards 51
labels 49
loading standard 19-20
photographic 34
plain 59
postcards 51
printing both sides 54-55
standard size in United States 28



part numbers, product 89
PhotoGrade ink cartridge
inserting 36
page setup for 37
printing with 34-36
removing and storing 37
turning off background printing 31
uses 10
photographs, printing 34-37
photo-quality paper 60
pictures, reversing 56
plain paper
page setup 37
specid instructions 62
tips 59
planning documents 27
platen, cleaning 82
plugging in the printer 1
portrait page orientation, in standard
document 28-29
ports
connecting printer and computer 6
selecting 70
seria in PowerBook 18
postcards
loading 62
printing 51-53
PostScript fonts 94-35
compatibility with TrueType fonts 97
icons 94-95
power, disconnecting 5
power adapter
pluggingin 5
requirements 88
unplugging in an emergency 2,5
PowerBook computer owners
printing problems 71
setup information 18
power button 8
power consumption 88
power cord
damaged 2
unplugging the power adapter 5

power light 8, 72-73
Power Macintosh users, printing
problems 8

precautions, safety 1-2, 68

premium paper 60

previewing printed page 30

Print command (File menu) 28, 30

printed page
aligning black and magentalines 22
previewing 30

printer
Apple supplies and accessories 89
cleaning 2, 66

connecting to computer 6
connecting to Local Talk network 7
cover 1,9
dimensions 87
failure 70
locating in work area 4
network name 17
pluggingin 5
ports 6
preventing damage 9, 68
resetting 37, 71
sharing 7
sow 73
weight 87
printer port, selecting in Chooser 16
printer software
installing 12-15
space required x
print head
cleaning 82
drying out 11
preventing damage 9
removing tape 10
printing
background 31-32
banners 38-41
canceling 32
color options 33
continuous document 61
custom-size paper 57-58

Index

121



122

?

Can't Find It?

See also Macintosh

Guide’s onscreen index.

Open the Guide (@)
menu and choose
Macintosh Guide
(or Mac OS Guide);
then click the

Index button.

Index

double-sided printing 54-55
duplex printing (two-sided) 54-55
envelopes 42-46

failure 70-71

flipped document 56

index cards 51-53

instructions 28-30

labels 49-50

manual duplex (two-sided) 54-55
monitoring activity 32, 70

page setup for 29

partial 80

patternsto align ink cartridges 22
photographs 34-37

planning 27

poor quality 79-83

postcards 51-53

previewing 30

problems 75

range of pages 30

resetting for normal 41

return address 42

sample pages 23

transparencies 47-48

two-sided 54-55

printing materials

Apple 89

choosing 59-62

cost 64

feeding improperly 74
quality 63
specifications 86
speed of printing 64

PrintMonitor command (Application

print requests, monitoring activity 32, 70

menu), checking and controlling

print requests 32, 54

print settings 30

Q

quality paper 60, 79
quality printing, setup for 30, 63

QuickDraw GX software,
incompatibility 12

R

radio interference vi

RAM (random-access memory),
requirements x

range of pages, printing 30

reception, radio and television vi

resolution 85

resume button 8

resume light 8-9, 11, 21, 72-73

return address 42

RGB color 107

rollers, cleaning 82

roman font 102

S

safety instructions 1-2, 68

sample pages, printing 23

scalable fonts 92-93

scaling, page setup 29

seria cable 6

seria ports, PowerBook 18

service provider 67

setting up
aligning ink cartridges 21-22
connecting printer to computer 6
directly connected printer 16
ink cartridges 9-11

learning about onscreen help 24-25

loading paper 19-20

on Local Talk network 17

PowerBook owners 18

printer software 12-15

printing sample pages 23

safety instructions 1-2

turning printer on and off 8

unpacking the printer 3-4

using electronic user's manual 26
setup, page. See page setup



sheet feeder. See paper trays
single-envelope slot 42
size, paper 29
software

installing for printer 12-15

space requirements x
software license agreement 13
specifications 85-87
speed of printing 64
dtains, ink 11, 82
standard documents 28
storage environment 88
storing ink cartridges 11, 35
substitution, font 104
suitcases, font 100-101
support provider 67
System Folder, font order in 99
system requirements x
system software

upgrading 12

verifying 13

T

technical information 85-89
television interference vi
text, reversing 56

tips, for choosing printing materials

59-62
top tray. See upper tray
transparencies
feeding improperly 74
loading 61
printing 47-48
specia instructions 62
troubleshooting
backwards printing 79
blinking lights 72-73

Color SW 4000 Seriesicon 68

computer failure 70
corrupted fonts 69

font problems 77
installation 68-69
jagged graphic images 78
memory problems 76-77
messages 76

off-center printing 78

page breaks 78

paper jams 74

PowerBook printing 71

print quality 79-83

dow printing 73

unaligned columns 79

using safety precautions 68
TrueType fonts 92-93

icon 92

specifications 86

using with bitmapped fonts 96-97
turning off the printer 8
turning on the printer 8
two-sided printing 54-55

page setup 29
typing paper 59

U

unpacking the printer 3-4
unplugging the printer 1-2
upper tray. See also paper trays
removing 51
replacing 53
user’s manual, electronic 26
US letter-size paper 19, 28

\

ventilation in work area 4

virtual memory, turning on 8

virus-detection software, turning off 13,
15, 68

voltage requirements 5

W, X, Y

warranty 67
whole document, printing 30
work area, locating printer 4

Z

Z-fold paper
loading 39-40
specid instructions 62

Index
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The Apple Publishing System

This Apple manual was written, edited, and produced on a desktop publishing system using
Apple Macintosh computers and QuarkXPress. Technical illustrations were drawn in Adobe™
Illustrator; screen shots were created and modified with system software, ExposurePro, and
Adobe Photoshop. Final pages were output using PostScript™ technology.

Text typeis Times®, display type is Helvetica® Narrow, and cover typeis Apple Garamond,
Appl€'s corporate font. Ornaments are custom symbols designed for Apple Computer. Some
elements, such as computer voice, are set in Courier, afixed-width font.

PostScript, the LaserWriter page-description language, was devel oped by Adobe Systems
Incorporated.
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